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Ihr neuer MP3-Player
Er sieht gut aus, ist zuverlässig und bietet viele praktische Funktionen.
Dank der hochmodernen Technologie von Samsung können Sie 
erstklassigen Sound und lebendige Bilder genießen. Wir wünschen 
Ihnen jederzeit viel Freude an Ihrem neuen Gerät – beim Sport, beim 
Download Ihrer Lieblingssongs, beim Anschauen von Videoclips oder 
einfach beim Radio hören!

EIN WAHRES MULTIMEDIA-GERÄT
In unserem MP3-Player steckt viel mehr, als der 
Name sagt. Sie können Bilder, Texte und Videos 
anzeigen und Ihre Lieblingssender im Radio 
hören. Durch die integrierte drahtlose Bluetooth-
Technologie lässt sich der MP3-Player vielseitig 
verbinden.

TOUCHSCREEN
Ihr MP3-Player verfügt über einen Touchscreen, 
der auf die Berührung Ihrer Finger reagiert.
Sie können verschiedene Vibrationseffekte 
einstellen.

EXTERNE SPEICHERKARTE
Ihr MP3-Player verfügt über einen eingebauten 
Speicherkartensteckplatz für MicroSDTM- und 
MicroSDHCTM-Karten, die vor allem dazu 
verwendet werden, Dateien und Daten zu 
speichern oder zu übertragen.

PRAKTISCHE WIDGETS
Ziehen Sie Uhr, Kalender und andere Widgets 
für einen einfachen und schnellen Zugriff in das 
Hauptmenü.
Sie können das Design der Tasten und Symbole 
im Bildschirmhintergrund verändern.

AUSGEZEICHNETER KLANG
Ihr neuer MP3-Player verfügt über DNSe™ 
(Digital Natural Sound Engine) – diese spezielle 
Klangtechnologie von Samsung sorgt für 
einen volleren und tieferen Klang und ein 
eindrucksvolles Hörerlebnis.



Sicherheitshinweise
Bedeutung der verwendeten Symbole und Hinweiszeichen

WARNUNG
Lebensgefahr oder ernsthafte Verletzungsgefahr.

VORSICHT
Verletzungsgefahr oder Gefahr eines Sachschadens.

ACHTUNG

Gefahr von Feuer, Explosionen, elektrischem Schlag oder 
sonstigen Verletzungen - bei der Benutzung des MP3-
Players die angegebenen Sicherheitsmaßnahmen einhalten.

HINWEIS

Tipps oder Verweise auf Seiten, die für die Benutzung
des Players hilfreich sein können.

KEINESFALLS ausführen.

NICHT öffnen.

NICHT berühren.

Befolgen Sie die Anweisungen genau.

Ziehen Sie den Netzstecker aus der Steckdose.

Wenden Sie sich an den Kundendienst.

Diese Warnhinweise sollen Sie und andere Personen vor Verletzungen
schützen. Bitte befolgen Sie sie genau. Bewahren Sie diesen Abschnitt nach 
dem Lesen sicher und griffbereit auf.



Sicherheitshinweise
Dieses Handbuch beschreibt die ordnungsgemäße Verwendung des MP3-
Players. Lesen Sie es aufmerksam durch, um Verletzungen von Personen oder 
Beschädigungen des Players zu vermeiden. Beachten Sie insbesondere die 
folgenden Warnhinweise.

SO SCHÜTZEN SIE SICH SELBST
Versuchen Sie nicht, das Gerät eigenhändig zu zerlegen, zu reparieren oder zu 
verändern.
Vermeiden Sie, dass das Gerät mit Wasser in Berührung kommt. Falls das Gerät 
nass wurde, schalten Sie es keinesfalls ein. Sie könnten einen elektrischen Schlag 
bekommen. Wenden Sie sich an den Samsung-Kundendienst in Ihrer Nähe.
Verwenden Sie das Produkt nicht bei Gewitter. Dies kann Stromschlag oder 
Fehlfunktionen des Geräts zur Folge haben.
Verwenden Sie während des Auto-, Motorrad- oder Fahrradfahrens niemals Ohr- 
oder Kopfhörer.
Dies kann zu schweren Unfällen führen und ist darüber hinaus in manchen Ländern 
gesetzlich verboten.
Wenn Sie Ohr- oder Kopfhörer tragen, achten Sie beim Spazierengehen oder Joggen 
auf einer Straße und insbesondere beim Überqueren von Straßen immer auf den 
Straßenverkehr. Andernfalls kann es zu schweren Unfällen kommen!
Sorgen Sie zu Ihrer eigenen Sicherheit dafür, dass sich das Ohr-/Kopfhörerkabel 
weder bei Ihnen noch in Gegenständen in Ihrer Nähe verfängt.
Bewahren Sie das Gerät nicht in feuchten, staubigen oder rußigen Umgebungen 
auf. Dies kann zu Bränden oder elektrischem Schlag führen.
Verwenden Sie das Produkt nicht, wenn der Bildschirm rissig oder beschädigt 
ist. Beschädigtes Glas oder Acryl kann Verletzungen an der Hand oder dem 
Gesicht verursachen.  Reichen Sie das Produkt in einer Samsung-Fachwerkstatt 
ein, damit der Bildschirm dort ersetzt werden kann. Schäden, die aufgrund einer 
Unachtsamkeit entstehen, werden nicht von der Garantie abgedeckt.

ACHTUNG

VORSICHT

ACHTUNG



SO SCHÜTZEN SIE SICH SELBST
Das Verwenden von Ohr- oder Kopfhörern über einen längeren Zeitraum kann 
schwere Gehörschäden verursachen.
Wenn Sie sich einer Lautstärke von mehr als 85 dB über einen längeren Zeitraum aussetzen, 
wird Ihr Hörvermögen negativ beeinträchtigt. Je höher die Lautstärke ist, desto größer ist der 
Gehörschaden (ein normales Gespräch wird mit 50 bis 60 dB geführt. Das durchschnittliche 
Straßengeräusch liegt bei 80 dB). Die Lautstärke sollte möglichst auf einen mittleren Wert 
eingestellt werden (das ist gewöhnlich weniger als 2/3 des Maximalwerts).
Wenn Sie ein Klingeln in den Ohren wahrnehmen, verringern Sie umgehend die 
Lautstärke, oder verzichten Sie ganz auf Ohr- oder Kopfhörer.
Die Batterie darf nicht übermäßiger Hitze wie Sonne, Feuer o.ä. ausgesetzt werden.

SO SCHÜTZEN SIE IHREN MP3-PLAYER
Setzen Sie den Player keinesfalls Temperaturen über 35 °C aus (wie z. B. in einer 
Sauna oder im Innenraum eines geparkten Fahrzeugs).
Vermeiden Sie übermäßige Krafteinwirkungen auf das Gerät. Lassen Sie den 
Player nicht fallen.
Stellen Sie keine schweren Objekte auf den Player.
Stellen Sie sicher, dass weder Staub noch Fremdkörper in das Gerät eindringen 
können.
Stellen Sie das Gerät nicht in die Nähe magnetischer Objekte.
Fertigen Sie von wichtigen Daten immer Sicherheitskopien an. 
Für Datenverlust übernimmt Samsung keine Haftung.
Verwenden Sie nur von Samsung mitgeliefertes oder zugelassenes Zubehör.
Sprühen Sie kein Wasser auf das Gerät. Reinigen Sie das Gerät keinesfalls 
mit Chemikalien wie Benzol oder mit Lösungsmitteln, da dies zu Bränden, 
elektrischem Schlag oder zu einer Beschädigung der Oberfl äche führen kann.
Die Nichtbeachtung dieser Anweisungen kann zu Verletzungen oder zu 
Beschädigungen des Players führen.

Falls Sie dieses Handbuch ausdrucken möchten, sollten Sie es in Farbe drucken und 
zur besseren Übersichtlichkeit die Option “1 Seite pro Blatt” wählen. 

ACHTUNG

HINWEIS

VORSICHT

ACHTUNG
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Grundlegendes
LIEFERUMFANG
Dieses Zubehör ist im Lieferumfang des MP3-Players enthalten. 
Sollte etwas fehlen, wenden Sie sich an den Kundendienst von Samsung.

Player Ohrhörer USB-Kabel

Das Design des Zubehörs kann aufgrund von Weiterentwicklungen ohne vorherige 
Ankündigung geändert werden.
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ABBILDUNGEN DES MP3-PLAYERS

Touchscreen

Ein/Aus-Taste und Sperrtaste (HOLD)
Betätigen Sie die Taste einmal, um den 
Touchscreen zu sperren.
Betätigen Sie die Taste noch einmal, um den 
Touchscreen zu entsperren.
Halten Sie zum Ein- bzw. Ausschalten des 
Geräts die Taste gedrückt.

Lautsprecher

Leiser-Taste
Mit dieser Taste verringern Sie die Lautstärke.

Lautsprecher

Lauter-Taste
Mit dieser Taste erhöhen Sie die Lautstärke.

LED-Leuchte

Mikrofon
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ABBILDUNGEN DES MP3-PLAYERS (Fortsetzung)

USB-Anschluss

Ohrhörer
Der linke Ohrhörer 
ist mit einem „L“, der 
rechte mit einem 
„R“ gekennzeichnet. 
Der Ohrhörer dient 
gleichzeitig als 
Antenne für das 
UKW-Radio.

Ohrhörer-Anschlussbuchse

Steckplatz für externe Speicherkarte
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SYSTEM ZURÜCKSETZEN
Wenn sich der MP3-Player nicht einschalten lässt, die Wiedergabe nicht funktioniert oder 
er vom angeschlossenen Computer nicht erkannt wird, muss das System zurückgesetzt 
werden.

Halten Sie die Taste [ ] länger als 10 
Sekunden lang gedrückt.

Das System wird neu initialisiert.
Einstellungen und Dateien im Player werden durch 
das Rücksetzen nicht beeinträchtigt.
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AKKU AUFLADEN
Vor der ersten Benutzung des Players muss der Akku aufgeladen werden.
Dies gilt auch, wenn Sie ihn längere Zeit nicht benutzt haben.

1. Verbinden Sie den kleineren Stecker des USB-Kabels mit dem USB-Anschluss am 
unteren Ende des MP3-Players.

2. Verbinden Sie den größeren USB-Stecker mit dem USB-Anschluss ( ) des 
Computers.

Ladezeit ca. 3 Stunden

Die Ladezeit kann je nach PC-Umgebung variieren.

Der Player kann nur aufgeladen werden, wenn dieser mit einem USB-Kabel an Ihren 
PC angeschlossen wird. Verwenden Sie keinen separat erworbenen USB-Adapter, da 
möglicherweise der Akku nicht aufgeladen wird und der Player nicht richtig funktioniert.

2
1

HINWEIS

Display-Anzeige

<USB connected >(USB verbunden)

< > - Ladevorgang

< > - Voll aufgeladen

ACHTUNG
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HINWEISE ZUM AKKU
Wenn Sie die folgenden Hinweise zu Pfl ege und Lagerung beachten, können Sie die 
Akku-Lebensdauer verlängern:
• Die Temperatur während des Ladevorgangs sollte zwischen 5 °C und 35 °C 

liegen.
• Den Akku nicht überladen (höchstens 12 Stunden aufl aden). Übermäßiges Laden 

oder Entladen kann zu einer Verkürzung der Lebensdauer des Akkus führen.  
• Die Lebensdauer des Akkus verkürzt sich allmählich mit dem Gebrauch.

Falls Sie den Player laden, während er an einem Laptop angeschlossen ist, sollte der Akku 
des Laptops voll aufgeladen sein bzw. der Laptop ans Stromnetz angeschlossen sein.
Der in diesem Gerät verwendete Akku kann nicht vom Benutzer ausgetauscht werden. Wenn 
Sie Informationen zum Austausch dieses Akkus benötigen, wenden Sie sich bitte an den 
Kundendienst.

GERÄT EIN- UND AUSSCHALTEN
Gerät einschalten
Drücken und halten Sie die Taste [ ].

Gerät ausschalten
Drücken und halten Sie die Taste [ ].

Ihr MP3-Player schaltet sich automatisch aus, wenn im Pausenmodus 5 Minuten lang keine 
Tasten oder Symbole betätigt wurden.

HINWEIS

HINWEIS

ACHTUNG
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LAUTSTÄRKE EINSTELLEN
Die Lautstärke kann bei laufender Wiedergabe eingestellt werden.

Drücken Sie die Tasten [ ], [ ].

DEN TOUCHSCREEN DEAKTIVIEREN
Über die Sperrfunktion wird der Touchscreen Ihres MP3-Players deaktiviert. Wenn Sie 
versehentlich, z. B. beim Sport, eine Taste drücken, wird somit die Musikwiedergabe 
nicht unterbrochen.

1. Drücken Sie die Taste [ ] ein Mal.

2. Drücken Sie nochmals die Taste [ ], um die 
Sperrfunktion wieder auszuschalten.

Wenn Sie <All> (Alle) unter <Settings> (Einstellungen)  <System>  <Hold Option> 
(Sperrfunktion) einstellen, werden der Touchscreen und alle anderen Tasten gesperrt. 
Weitere Informationen fi nden Sie auf Seite 45.

HINWEIS
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MIT DEM “DATEIBROWSER” NACH DATEIEN SUCHEN
Sie können Dateien ganz einfach mit der Funktion <File Browser> (Dateibrowser) 
suchen.

1. Wählen Sie das Symbol im Hauptmenü.

2. Wählen Sie einen Ordner aus, um die Dateiliste anzuzeigen.

3. Wählen Sie eine Datei aus.
Die Datei wird abgespielt bzw. angezeigt.

MIT DEM “DATEIBROWSER” DATEIEN LÖSCHEN
Führen Sie die oben genannten Schritte 1–2 aus.

3. Tippen Sie auf das Symbol [  ].

4. Wählen Sie <Delete> (Löschen).

5. Wählen Sie die zu löschende Datei aus und tippen Sie auf <OK>.
Tippen Sie auf das Symbol [  ], um alle Dateien auszuwählen.

Die Datei wird gelöscht.

Sie können eine Datei direkt in der Dateiliste des Video- oder Musikmodus sowie im <File 
Browser> (Dateibrowser) löschen.
Die Datei kann während der Wiedergabe nicht gelöscht werden.

Gelöschte Dateien können nicht wiederhergestellt werden.

HINWEISE

ACHTUNG
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STATUSANZEIGEN ÜBERPRÜFEN
Die aktuellen Statusanzeigen des Players werden im oberen Bildschirmbereich 
angezeigt.

Alarmanzeige Sperranzeige

Bluetooth-Anzeige Uhrzeit

Speicherkartenanzeige Akkuladezustand

Die Bildschirmdarstellungen dienen nur zur Veranschaulichung. Die tatsächliche 
Bildschirmanzeige kann von den Abbildungen abweichen.HINWEIS
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TOUCHSCREEN VERWENDEN
Tippen Sie leicht mit dem Daumen oder der Fingerspitze auf den Touchscreen.

Berühren Sie den Touchscreen vorsichtig, um Schäden am Bildschirm zu vermeiden.

Bedienen Sie den Touchscreen zum Vermeiden von Beschädigungen nur mit den Fingern.

Berühren Sie den Touchscreen nur mit sauberen Fingern.

Bedienen Sie die Touchscreen-Tasten nicht mit Handschuhen.

Möglicherweise funktioniert der Touchscreen nicht, wenn Sie ihn mit dem Fingernagel oder 
anderen Objekten wie z. B. einem Kugelschreiber bedienen.

HINWEISE
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TOUCHSCREEN VERWENDEN (Fortsetzung)

Antippen
Tippen Sie auf die gewünschte Stelle des Touchscreens.

Beispiele
Einen Menüpunkt 
auswählen oder zum 
nächsten Bildschirm 
wechseln

1. Tippen Sie auf das entsprechende Symbol, um eine 
Funktion auszuführen, oder wählen Sie ein Element 
aus einer Liste.

Wiedergabeinformationen 
und Symbole anzeigen

2. Tippen Sie auf den Touchscreen, um 
Wiedergabeinformationen oder Video-, Musik-, Bild- 
und Textsymbole anzuzeigen.
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TOUCHSCREEN VERWENDEN (Fortsetzung)

Längeres Berühren
Berühren Sie länger die gewünschte Stelle des Touchscreens.

Beispiele

Zum vorherigen 
Wiedergabebildschirm 
wechseln

1. Berühren Sie länger das Symbol  oder ,
um eine vor kurzem gespielte Datei wiederzugeben 
oder zum Wiedergabebildschirm der aktuellen Datei 
zu wechseln.

Videokapitel erstellen2.
Halten Sie den Finger während der Videowiedergabe 
auf dem Bildschirm, um das aktuelle Video in 
insgesamt 5 Kapitel zu unterteilen.
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TOUCHSCREEN VERWENDEN (Fortsetzung)

Ziehen
Tippen Sie mit dem Finger zunächst auf ein Symbol, und ziehen Sie es dann an
die gewünschte Stelle.

Beispiele

Hauptmenü
durchsuchen

1. Tippen Sie auf eine freie Stelle des Touchscreens, und 
ziehen Sie den Finger in horizontaler Richtung, um das 
Hauptmenü zu verschieben.

Zur vorhergehenden/
nächsten Liste wechseln

2. Sie können durch vertikales Ziehen im Musik- und 
Videobildschirm die vorherige/nächste Liste durchsuchen.

Wiedergabe-
Statusbalken steuern

3. Tippen Sie auf den Statusbalken für die Wiedergabe auf 
dem Display und ziehen Sie Ihren Daumen oder Finger zu 
der gewünschten Stelle, bevor Sie loslassen. 

Seite wechseln/
während der
Wiedergabe suchen

4.

Führen Sie mit Ihrem Finger eine horizontale 
Ziehbewegung während der Video- oder Musikwiedergabe 
durch, um zum vorherigen/nächsten Titel zu wechseln, 
je nach den unter „Horizontale Linie“ vorgenommenen 
Einstellungen.
Führen Sie mit Ihrem Finger eine horizontale 
Ziehbewegung während der Bildanzeige durch, um zum 
vorherigen/nächsten Bild zu wechseln.
Führen Sie mit Ihrem Finger eine horizontale 
Ziehbewegung während der Textanzeige durch, um zur 
vorherigen/nächsten Seite zu wechseln.

Widget-Symbole 
verschieben

5. Wählen Sie während der Verwendung von Widgets
im Hauptmenü ein Widget-Symbol aus, um es an die 
gewünschte Stelle zu verschieben.
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ANZEIGE DES HAUPTMENÜS EINSTELLEN
Tippen Sie im Hauptmenü auf das Symbol [ ] im unteren Bereich, um ein Kontextmenü 
anzeigen zu lassen, in dem Sie das Hauptmenü anpassen können.

1
Sie können das Design des 
Hauptmenüs ändern.

2

Sie können das Layout des 
Hauptmenüs individuell anpassen, 
indem Sie jedes Hauptmenü-Symbol an 
die gewünschte Stelle verschieben.

3
Sie können im Hauptmenü Widget-
Symbole hinzufügen oder löschen.

Menüdesign ändern
Wählen Sie mit [ , ] das gewünschte Menüdesign aus.

1 2 3
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ANZEIGE DES HAUPTMENÜS EINSTELLEN (Fortsetzung)

Menülayout ändern
Tippen Sie auf ein Menüsymbol und ziehen Sie es auf die gewünschte Stelle/Seite.

Zum Entfernen eines Symbols aus dem Hauptmenü ziehen Sie das Symbol aus dem 
Hauptmenü in die untere Menüleiste.

Widget-Symbol hinzufügen/löschen
Ziehen Sie ein Widget aus der Widget-Leiste in das Hauptmenü oder umgekehrt.
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WIDGET-SYMBOLE
Widgets sind kleine Computerprogramme oder Applikationen, die in eine grafi sche 
Benutzeroberfl äche (GUI) eingebunden sind. Sie liefern visuelle Informationen und 
ermöglichen einen einfachen Zugriff auf häufi g verwendete Tools wie Uhr, Kalender 
oder Notizblock. Ordnen Sie Uhr, Kalender und andere Widgets für einen einfachen und 
schnellen Zugriff im Hauptmenü an.

Sie können eine Analoguhr mit der aktuellen Uhrzeit einblenden. 
Die Uhrzeit kann auch eingestellt werden. Siehe Seite 28.

Sie können eine Digitaluhr mit der aktuellen Uhrzeit einblenden. 
Die Uhrzeit kann auch eingestellt werden. Siehe Seite 28.

Sie können ein Memo eingeben und speichern. Siehe Seite 29.

Sie können sich einen Kalender und Ihre Termine anzeigen lassen. 
Siehe Seite 30.

Sie können sich die aktuelle Uhrzeit in verschiedenen Städten der 
Welt anzeigen lassen. Siehe Seite 31.

Sie können sich gespeicherte Bilder als Diashow ansehen.
Sie können einzelne Ordner für die Diashow auswählen. 
Siehe Seite 32.

Tippen Sie auf die Glühbirne, um die Helligkeit des Touchscreens 
einzustellen.

Sie können die Helligkeit auch unter <Settings> (Einstellungen)  <Display> 
 <Brightness> (Helligkeit) einstellen. Siehe Seite 42.
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WIDGET-SYMBOLE (Fortsetzung)

Tippen Sie auf dieses Widget, um den Timer einzustellen. Das 
Gerät wird nach der vorgegebenen Zeit automatisch abgeschaltet.

Sie können den Timer auch unter <Settings> (Einstellungen)  <System> 
(System)  <Sleep> (Timer) einstellen. Siehe Seite 45.

Sie können die verbleibende Akkuenergie überprüfen.

Sie können unter dem Bildschirm für das Hauptmenü Musik hören
oder das UKW-Radio einschalten, ohne dafür in die Modi Musik 
oder UKW-Radio wechseln zu müssen. 

Dekoratives Widget mit einer Blume, um die beim Antippen ein 
Schmetterling fl iegt.

Dekoratives Widget mit Blüte, deren Blütenblätter sich beim 
Antippen lösen.

Dekoratives Widget mit Kaffeetasse, aus der beim Antippen heißer 
Dampf aufsteigt.

Dekoratives Widget mit einem Keks, der beim Antippen leicht 
zerbricht.
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WIDGETS VERWENDEN

Aktuelle Uhrzeit einstellen

1. Tippen Sie auf die Digital- oder Analoguhr im Hauptmenü.

2. Stellen Sie jeweils <Year> (Jahr), <Month> (Monat), <Day>
(Tag), <Hour> (Stunde), <Min> (Minute), <AM, PM> ein.

3. Tippen Sie auf <OK>.

Optionen für das Uhr-Widget 
<Style> (Stil): Sie können das Design des Uhr-Widgets im Hauptmenü ändern.

Sie können die aktuelle Uhrzeit auch unter <Settings> (Einstellungen)  <Time> 
(Zeit)  <Date&Time> (Datum&Zeit) einstellen. Siehe Seite 44.HINWEIS
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WIDGETS VERWENDEN (Fortsetzung)

Memo eingeben

1. Tippen Sie auf das Memo-Widget im Hauptmenü.

2. Wählen Sie <New Memo> (Neues Memo).

3. Geben Sie ihr Memo ein und tippen Sie auf <OK>.
Informationen zur Benutzung der Tastatur fi nden Sie auf Seite 35.

Optionen für das Memo-Widget 
<Style> (Stil): Sie können das Design des Memo-Widgets im Hauptmenü 
ändern.
<Delete> (Löschen): Sie können ein gespeichertes Memo löschen.

Als Hauptmemo festlegen 
Zeigt ein Memo im Hauptmenü an.
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WIDGETS VERWENDEN (Fortsetzung)

Kalender/Termine anzeigen
Sie können Termine nur einsehen, wenn eine mit MS Offi ce Outlook erstellte 
Datei (ics-Format) unter <File Browser> (Dateibrowser)  <My Pack> (Mein 
Paket)  <Calendar> (Kalender) gespeichert wurde.

1. Tippen Sie auf das Kalender-Widget im Hauptmenü.

2. Wählen Sie den gewünschten Monat aus.
Führen Sie mit Ihrem Daumen oder Finger eine vertikale 
Ziehbewegung durch, um den gewünschten Monat auszuwählen. 
Führen Sie mit Ihrem Daumen oder Finger eine horizontale 
Ziehbewegung durch, um das gewünschte Jahr auszuwählen.

3. Wählen Sie im Kalender ein Datum mit Terminsymbol aus.

4. Wählen Sie den gewünschten Termin aus.
Ihr Termin wird angezeigt.

Optionen für das Kalender-/Termin-Widget
<Style> (Stil): Sie können das Design des Kalender-Widgets im Hauptmenü ändern.
<Delete All Schedule> (Löschen Sie alle Ereignisse.): Löscht alle gespeicherten 
Termine.

Termine können nicht auf dem Player erstellt werden.
HINWEIS
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WIDGETS VERWENDEN (Fortsetzung)

Weltzeituhr ändern

Sie können einige der größten Städte der Welt sowie Datum und Uhrzeit an 
diesen Orten je nach deren Zeitzone anzeigen.

Bevor Sie beginnen - Stellen Sie zunächst die aktuelle Uhrzeit ein. Informationen 
dazu fi nden Sie auf Seite 44. 
Stellen Sie die gewünschte Zeitzone unter <Settings> (Einstellg.)  <Time> (Zeit) 

 <Time Zone> (Zeitzone) ein. Siehe Seite 44.

1. Tippen Sie auf das Weltzeit-Widget im Hauptmenü.
Sie können die Zeitzone für die obere und die untere Uhr 
einstellen.

2. Wählen Sie die gewünschte Zeitzone aus, und tippen Sie 
auf <OK>.

Weltzeituhr-Optionen 
<Style> (Stil): Sie können das Design des Weltzeit-Widgets im Hauptmenü ändern.
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WIDGETS VERWENDEN (Fortsetzung)

Diashow anzeigen

Tippen Sie auf das Diashow-Widget im Hauptmenü.
Die Diashow wird gestartet.

Tippen Sie während der Diashow ein Mal auf das Display, um das 
Symbol anzuzeigen, mit dem Sie die Optionen einstellen können.

Diashow-Optionen
<Select Slideshow Folder> (Ordner f. Diashow wählen): Sie können einen Ordner 
wählen, dessen Bilder in einer Diashow angezeigt werden sollen. Die Bilder des 
ausgewählten Ordners werden in zufälliger Reihenfolge in der Diashow angezeigt.
<Change Frame> (Bild ändern): Sie können die Form des Bildrahmens für das 
Diashow-Widget im Hauptmenü ändern.
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MINI-PLAYER UND SCHNELLSTARTLEISTE VERWENDEN

Mini-Player und Schnellstartleiste öffnen

Tippen Sie auf den oberen Bereich des Touchscreens (in allen 
Bildschirmen außer dem Hauptmenü-Bildschirm).

Mini-Player und Schnellstartleiste schließen

Tippen Sie auf den Touchscreen.

Mini-Player verwenden

Mit dem Mini-Player können Sie Musik oder UKW-Radio hören, ohne in den 
Modus für Musik oder UKW-Radio zu wechseln.

Tippen Sie auf das Symbol [ , ,  ], um vor-
oder zurückzuspringen oder die Wiedergabe zu pausieren.

Die Wiedergabestatusleiste des Mini-Players kann nicht verstellt 
werden.HINWEIS
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1 2 3 4

MINI-PLAYER UND SCHNELLSTARTLEISTE VERWENDEN 
(Fortsetzung)

Schnellstartleiste verwenden

Die Schnellstartleiste ermöglicht den schnellen Zugriff auf das Hauptmenü 
und die Einstellungen zu Tonausgabe, Sperre/Display aus und Verbindung mit 
Bluetooth-fähigem Stereo-Headset.

1 Zum Aufrufen des Hauptmenüs.

2

Zum Einstellen der Tonwiedergabe über 
Kopfhörer oder Lautsprecher.

Wählen Sie zwischen den Symbolen 
[  ] (Auto), [  ] (Ohrhörer) und 
[  ] (Lautsprecher). Siehe Seite 41.

3

Den Bildschirm ausschalten und den 
Touchscreen sperren. 
Dies gibt Ihnen die Möglichkeit, Musik 
zu hören und gleichzeitig Akkuenergie 
zu sparen.

4

Hiermit wird automatisch die 
Verbindung zu einem Bluetooth-
Stereoheadset hergestellt oder 
getrennt.

Falls das Bluetooth-Stereo-Headset nicht 
registriert ist, kann keine Verbindung 
hergestellt werden. Ausführlichere 
Informationen fi nden Sie unter <Bluetooth-
Stereo-Headset verwenden>. Siehe Seite 108.
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VIRTUELLE TASTATUR VERWENDEN
Sie können die virtuelle Tastatur verwenden, um Eintragungen in das Memo 
vorzunehmen, Ihre persönlichen Informationen einzugeben und ein Bluetooth-Gerät 
umzubenennen.

Text eingeben

Verwenden Sie die virtuelle Tastatur, um einen Text einzugeben, und tippen Sie 
dann auf <OK>.

Der Eingabemodus wechselt in 
Reihenfolge der Tastenzeichen. 

Z. B. [Aa1]: Der Eingabemodus wechselt 
in der Reihenfolge Großschreibung
Kleinschreibung  Zahl.

Bewegt den Cursor rückwärts/
vorwärts.

Hiermit können Sie Zeichen einzeln 
löschen.

Hiermit können Sie ein Leerzeichen 
einfügen.

Sie können Zeilenumbrüche 
einfügen.

Löscht den gesamten Text.

Der Tastaturtyp ist je nach Nutzungsbedingungen unterschiedlich.
HINWEIS
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LISTENANZEIGEMODUS WECHSELN
Sie können zwischen verschiedenen Listenanzeigemodi für Video-, Musik- und 
Textmodus wählen.

Videos

In der Miniaturansicht sehen Sie die zuletzt wiedergegebene Szene und die 
Wiedergabezeit eines Videos. 

Musik

Sie können den Listenanzeigemodus im Bildschirm <Alben> ändern.

HINWEIS

HINWEIS
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LISTENANZEIGEMODUS WECHSELN (Fortsetzung)

Bilder

Texte

Sie können überprüfen, wieviel Prozent des Textes bereits angezeigt wurden.
HINWEIS
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ANSCHLUSS AN EIN FERNSEHGERÄT
Schließen Sie den Player mit einem zusätzlichen TV-OUT-Kabel an ein Fernsehgerät an, 
um Multimedia-Dateien, wie Fotos oder Videos, auf dem Fernsehbildschirm betrachten 
zu können.

Bevor Sie beginnen - Stellen Sie unter <Settings> (Einstellg.)  <System>  <TV 
out Type> (TV-Ausgangsmodus) die TV-Norm für den TV-Ausgang je nach Gebiet ein. 
Informationen dazu fi nden Sie auf Seite 45.

1. Verbinden Sie Ihren Player mithilfe eines TV-OUT-Kabels (optional) mit einem 
Fernsehgerät.

2. Stellen Sie an Ihrem Fernsehgerät den Video-/Audioeingang entsprechend der 
Kabelverbindung ein.

3. Wählen Sie ein Video oder ein Bild auf Ihrem Player.
4. Tippen Sie auf das Symbol [  ].
5. Wählen Sie <TV out> (TV-Ausgang).

Auf dem Bildschirm des Fernsehgerätes wird das Foto oder Video angezeigt, das auf Ihrem 
Player wiedergegeben wird.

Im Modus TV-Ausgang erfolgt die Ausgabe des Tons nur über die Lautsprecher des 
Fernsehgerätes.
Einige Funktionen Ihres Players stehen möglicherweise nicht zur Verfügung, wenn der Player 
an ein Fernsehgerät angeschlossen ist.
Tippen Sie im Modus TV-Ausgang auf das Symbol [  ], um den Modus zu verlassen.

HINWEISE
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BILDSCHIRMROTATION VERWENDEN
Der Player ist mit einem Sensor ausgestattet, der den Kippwinkel des Players erkennt, 
und den Bildschirm entsprechend horizontal oder vertikal dreht.

Drehen Sie den Player seitlich für eine horizontale Ansicht.

Diese Funktion steht bei einigen Anzeigemodi für Listen, Musik, Bilder und Text zur 
Verfügung.HINWEIS
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EINSTELLUNGEN ÄNDERN
Sie können die Werkseinstellungen ändern, um den MP3-Player Ihren Bedürfnissen 
anzupassen.

1. Wählen Sie das Symbol im Hauptmenü.

2. Wählen Sie aus der Einstellungsliste die gewünschte Position 
aus.

3. Wählen Sie die gewünschte Einstellung.

4. Stellen Sie die gewünschten Optionen ein.

[Einstellmenü]
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EINSTELLUNGEN ÄNDERN (Fortsetzung)

Optionen für Toneinstellungen
Sie können die Optionen Master-EQ, Lautstärkebegrenzung usw. einstellen.

Street Mode (Street-Modus): Wenn Sie auf der Straße Musik 
hören, können Sie mit dieser Option einige Geräusche herausfi ltern 
und damit von besserer Klangqualität profi tieren
Audio Upscaler (Audio-Upscaling-Funktion): Mit dieser Funktion 
können Audiodateien hochskaliert werden, so dass der Klang dem 
Originalton näher kommt. 
myDNSe: Sie können die Optionen für DNSe Ihren Bedürfnissen 
entsprechend einstellen.Sie können bis zu 2 Optionen für myDNSe 
einstellen.
Vibe Woofer: Je nach Stärke des Beats stehen Ihnen 
verschiedene Vibrationseffekte zur Verfügung. Sie können die 
Option entsprechend der Musik oder des Videos einstellen.
Touch Tone (Touch-Ton): Sie können die Lautstärke des Touch-Tons und die 
Vibrationsstufe einstellen.
Notifi cation/Alert tone (Benachricht./Alarmton): Sie können die Tonlautstärke und die 
Vibration von Alarm- und Bestätigungstönen einstellen. 
Wise Volume (autom. Lautstärkebegrenzung): Sie können Hörschäden vermeiden, 
indem Sie bei der Verwendung von Ohrhörern die Lautstärke begrenzen. Falls <On> 
(Ein) eingestellt ist, wird eine Warnmeldung angezeigt, sobald Sie über längere Zeit 
höheren Lautstärkestufen ausgesetzt waren. Die Lautstärke wird automatisch auf 
verträgliche Stufen gesenkt. 
Bei der Einstellung <Off> (Aus) wird die Maximallautstärke auf 30 eingestellt. Auch wenn 
<Off> (Aus) gewählt wurde, wird die Maximallautstärke beim erneuten Einschalten des 
Players auf 15 zurückgestellt. Dadurch sollen Hörschäden vermieden werden.
Output (Ausgabe): Sie können die Tonausgabe auf Lautsprecher oder Ohrhörer 
einstellen. Falls Sie <Auto> (Auto) wählen, können Sie den Ton über angeschlossene 
Ohrhörer hören. Sind diese nicht angeschlossen, wird der Ton über den integrierten 
Lautsprecher ausgegeben.
Master EQ (Master-EQ): Mit dieser Option kann der Ton optimiert werden. Wählen Sie 
die gewünschte Frequenz und deren Wert aus.
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EINSTELLUNGEN ÄNDERN (Fortsetzung)

Optionen für Display-Einstellungen
Hier können Sie Schrift, Abschaltzeit, Display-Helligkeit usw. einstellen.

Font (Schrift): Sie können die Schriftart der Menüsprache 
ändern. Für einige Menüsprachen kann <Font> (Schrift) nicht 
gewählt werden.
Random Skin (Zufallsdesign): Sie können im Ordner <Pictures> 
(Bilder)  <Skin> (Design) Bilddateien als Hintergrundbild 
auswählen. Diese werden dann beim Einschalten des Players in 
zufälliger Reihenfolge angezeigt. Ausführlichere Informationen 
zum Speichern von Bildern im Ordner <Skin> (Design) fi nden Sie 
auf Seite 78.
Wenn Sie bei aktiviertem Zufallsdesign in der Bilderliste ein Bild 
mit <Assign> (Zuweisen)  <My Skin> (Mein Design) auswählen, 
so wird die Einstellung <Zufallsdesign> automatisch deaktiviert.

Reset My Skin (M. Des. zurücks.): Das Hintergrundbild des Touchscreens wird auf 
das Standardbild zurückgesetzt.. Wählen Sie <Yes> (Ja), um das Hintergrundbild 
zurückzusetzen.
Reset Booting Image (Startbild zurücksetzen): Setzt das Startbild (das Bild, welches 
beim Starten des Players angezeigt wird) auf die Standardeinstellungen zurück. Wählen 
Sie <Yes> (Ja), um das Startbild zurückzusetzen. Informationen zur Einstellung des 
Startbilds fi nden Sie auf Seite 78.
Display Off & Hold (Display aus&halt.): Das Display wird automatisch ausgeschaltet, 
wenn während des voreingestellten Zeitraums keine Tasten gedrückt oder Symbole 
angetippt werden. Wenn sich der Touchscreen ausschaltet, so ist er gesperrt. 
Brightness (Helligkeit): Mit dieser Funktion können Sie die Helligkeit des Displays 
einstellen.
LED Effect (LED-Effekt): Sie können die LED-Effektleuchte ein- oder ausschalten.
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EINSTELLUNGEN ÄNDERN (Fortsetzung)

Optionen für Spracheinstellungen
Für die Menüanzeige des MP3-Players steht eine Vielzahl von Sprachen 
zur Verfügung. Wählen Sie einfach die gewünschte Sprache aus.

Menu (Menü): Zum Einstellen der Menüsprache.
Wählen Sie zwischen <English>, < >, <Français>, 
<Deutsch>, <Italiano>, < >, < >, < >,
<Español>, < >, <Magyar>, <Nederlands>, <Polski>, 
<Português>, <Svenska>, < >, < eština>, < >,
<Türkçe>, <Norsk>, <Dansk>, <Suomi>, <Español(Sudamérica)>, 
<Português(Brasil)>, <Indonesia>, <Ti ng Vi t>, < >,
<Romani>, < >, <Slovenš ina> oder <Slovenský>.

Contents (Inhalt): Hier legen Sie die Sprache für die Anzeige von 
Text und Titelinformationen fest.
Wählen Sie zwischen <English>, <Korean>, <French>, <German>, 
<Italian>, <Japanese>, <Chinese(S)>, <Chinese(T)>, <Spanish>, <Russian>, 
<Hungarian>, <Dutch>, <Polish>, <Portuguese>, <Swedish>, <Thai>, <Finnish>, 
<Danish>, <Norwegian>, <Farsi>, <Afrikaans>, <Basque>, <Catalan>, <Czech>, 
<Estonian>, <Greek>, <Hrvatski>, <Icelandic>, <Romanian>, <Slovak>, <Slovene>, 
<Turkish> oder <Vietnamese>.

Jeweils unterstützte Sprachen können sich ändern oder hinzugefügt werden.
HINWEIS
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EINSTELLUNGEN ÄNDERN (Fortsetzung)

Optionen für Zeiteinstellungen
Über diese Option können Sie Datum und Uhrzeit, Datumstyp und auch die 
Zeitzone einstellen.

Date&Time (Datum&Zeit): Hier können Sie das aktuelle Datum 
und die aktuelle Uhrzeit einstellen. Tippen Sie auf den oberen 
oder unteren Bereich der Werte für <Year> (Jahr), <Month> 
(Monat), <Day> (Tag), <Hour> (Stunde), <Min> (Min.) und das 
Symbol <AM, PM>, um das Datum und die aktuelle Uhrzeit 
einzustellen.
Date Type (Datumstyp): Hier können Sie festlegen, in welchem 
Format das Datum auf dem Display dargestellt werden soll.
Time Zone (Zeitzone): Sie können die aktuelle Uhrzeit 
überprüfen, indem Sie die Zeitzone einer bestimmten Stadt auf 
der Welt auswählen. Damit Informationen zur Weltzeit angezeigt 
werden können, muss zunächst die Zeitzone ausgewählt werden 
- siehe Seite 31.
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EINSTELLUNGEN ÄNDERN (Fortsetzung)

Optionen für Systemeinstellungen
Stellen Sie den Sleep-Timer und die Standardeinstellung Ihren Wünschen 
entsprechend ein.

My Info (Meine Info): Sie können Ihren Namen sowie Ihr 
Geburtsdatum einstellen.

Einstellungen zu My Name (Mein Name) - Tippen Sie 
auf den Eingabebereich unterhalb von <My Name> (Mein 
Name) und geben Sie ihren Namen ein. Informationen zur 
Benutzung der Tastatur fi nden Sie auf Seite 35.
Einstellungen zu My Birthday (Mein Geburtstag) 
- Tippen Sie im oberen oder unteren Bereich der Werte 
für <Year> (Jahr), <Month> (Monat) und <Day> (Tag), um 
Ihren Geburtstag einzustellen.

Sleep (Timer): Das Gerät wird nach einer vorgegebenen Zeit 
automatisch abgeschaltet. 
Auto Pivot (Automatisches Schwenken): Sie können die 
automatische Bildschirmrotation ein- oder ausschalten.
PC Connection (PC-Verbindung): Sie können die USB-Verbindung zum Computer 
entweder als <MTP> oder <MSC> festlegen. Die (werkseitige) Standardeinstellung 
der PC-Verbindung ist <MTP>. Mit der Einstellung auf <MSC> erfüllt der Player die 
Funktionen eines Wechseldatenträgers. Siehe Seite 47.
TV out Mode (TV-Ausgangsmodus): Um auf dem Player gespeicherte Videos oder 
Fotos auf einem Fernsehgerät anzuzeigen, müssen Sie das TV-System (PAL/NTSC) des 
angeschlossenen Fernsehgerätes auswählen.
Hold Option (Sperrfunktion): Mit der Sperrfunktion können alle Tasten und der 
Touchscreen oder nur der Touchscreen gesperrt werden. Weitere Informationen fi nden 
Sie auf Seite 17.
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EINSTELLUNGEN ÄNDERN (Fortsetzung)

Optionen für Systemeinstellungen (Fortsetzung)

Default Set (Rücksetzen): Setzt alle Einstellungen auf die Standardwerte zurück.
Format (Formatieren): Zum Formatieren des internen Speichers. Bei <Yes> (Ja) 
wird der interne Speicher formatiert und alle Dateien auf dem Player werden gelöscht. 
Überprüfen Sie den internen Speicher vor dem Formatieren.
About (Info): Hier werden Informationen zu Firmware-Version und Speicherkapazität 
angezeigt.

Firmware - Zeigt die aktuelle Firmware-Version an.
Memory (Speicher) - Unter <Used> (Genutzt) wird der belegte Speicherplatz 
angezeigt, unter <Remaining> (Verfügbar) der freie Speicherplatz und unter 
<Total> (Gesamt) die Gesamtspeicherkapazität.

Sie brauchen für die Aktualisierung im Player einen freien Speicherplatz von 
mindestens 300 MB.

Hinweis zum eingebauten Speicher
1 GB = 1.000.000.000 Bytes; die verfügbare Speicherkapazität ist etwas
geringer als die angegebene Speicherkapazität, da ein Teil des Speichers von der 
internen Firmware beansprucht wird. 

HINWEIS
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EINSTELLUNGEN ÄNDERN (Fortsetzung)

Bei Einstellung der PC-Verbindung auf <MSC>

Dateien auf einen Wechseldatenträger übertragen
Wenn der Player an einen Computer angeschlossen ist, wird er als 
Wechseldatenträger erkannt und Sie können Dateien vom und zum Computer 
übertragen.

Bevor Sie beginnen - Verbinden Sie den Musik-Player mit Ihrem Computer.

1. Öffnen Sie die Ordner mit den Dateien, die 
Sie von Ihrem PC übertragen möchten.

2. Öffnen Sie <My Computer>
(Arbeitsplatz) <M1> auf Ihrem 
Desktop.

3. Wählen Sie die Dateien/Ordner aus, 
die Sie von Ihrem PC übertragen 
wollen, und ziehen Sie diese mit der Maus in den 
gewünschten Ordner unter <M1>.

Die ausgewählten Dateien bzw. Ordner werden auf den 
Player übertragen.

Die Reihenfolge, in der die Musikdateien auf Ihrem PC angezeigt werden, kann von 
der auf Ihrem Player abweichen.
Wenn Sie eine DRM-Datei (Digital Rights Management) auf den Player übertragen, 
wird die Datei nicht gespielt.
Wählen Sie bei der Formatierung des Players am Computer FAT 32 als Dateiformat.
Klicken Sie unter Windows Vista auf „Gerätestandards wiederherstellen“, und 
formatieren Sie den Player.
Was ist DRM?
DRM (Digital Rights Management) ist eine Technik, mit deren Hilfe die illegale Verwendung 
digitaler Inhalte verhindert und der Profi t sowie die Rechte der Urheberrechtsinhaber 
gewahrt werden. DRM-Dateien sind mit Kopierschutz versehene Musikdateien.

HINWEIS

ACHTUNG
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EINSTELLUNGEN ÄNDERN (Fortsetzung)

Bei Einstellung der PC-Verbindung auf <MSC> (Fortsetzung)

Vom PC trennen
Folgen Sie den unten stehenden Anweisungen, wenn Sie den Player vom PC 
lösen, um Schäden an Produkt und Daten zu vermeiden.

1. Klicken Sie mit der linken Maustaste 
auf das Symbol  in der Taskleiste 
in der unteren rechten Ecke des 
Desktops.

2. Klicken Sie auf die Meldung 
<Safely Remove USB Mass 
Storage Device Drive> (USB-
Massenspeichergerät sicher 
entfernen).

3. Trennen Sie das Gerät von Ihrem 
PC.

Trennen Sie die Verbindung zwischen 
Player und Computer nicht während 
der Übertragung. Dies kann zur 
Beschädigung des Players oder des 
Computers führen.
Sie können den Player nicht vom PC entfernen (kein sicheres Entfernen möglich), 
während Musiktitel auf dem Computer wiedergegeben werden, die sich auf dem 
Player befi nden. Bitte versuchen Sie es nach dem Ende der Wiedergabe erneut.

ACHTUNG

1

2
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EmoDio
EmoDio ist eine Softwareanwendung für diesen MP3-Player mit verschiedenen 
inhaltsbezogenen Diensten und Unterstützung für verschiedene Geräte.
EmoDio kann aus Gründen der Verbesserung ohne eine vorherige 
Benachrichtigung verändert werden.

Bevor Sie beginnen  - Beachten Sie die Kurzanleitung des Players, um Informationen über 
die Installation von <EmoDio> zu erhalten.
Verbinden Sie den Player mit dem Computer und starten Sie <EmoDio>.

SYSTEMVORAUSSETZUNGEN
Für das Ausführen von EmoDio sind folgende Mindestvoraussetzungen erforderlich:

• Windows XP Service Pack 2 oder höher
• Windows Media Player 11.0 oder höher
• Pentium 500 MHz oder höher
• Aufl ösung 1024 X 768 oder höher
• Internet Explorer 6.0 oder höher
• DirectX 9.0 oder höher
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EMODIO VERWENDEN
EmoDio ist eine benutzerfreundliche Softwareanwendung, die Ihnen bei der Organisation 
Ihrer Dateien auf Ihrem Computer hilfreich ist. Dateien, die in EmoDio sortiert und 
organisiert wurden, können schnell und ohne langes Durchsuchen der Festplatte auf den 
MP3-Player übertragen werden.

“Mit <EmoDio> können Dateien problemlos vom Computer auf den MP3-Player 
übertragen werden.

Sie können Ihre eigene Sammlung oder Ihr eigenes Album von Audiodateien 
zusammenstellen.

    Außerdem können Sie Blog-Daten und in RSS gespeicherte Dateien auf den MP3-
Player übertragen und dort wiedergeben.
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EMODIO VERWENDEN (Fortsetzung)

Mit EmoDio Dateien auf den Player übertragen

1. Verbinden Sie den Player mithilfe eines USB-Kabels mit Ihrem Computer.
<EmoDio> wird automatisch gestartet, sobald der Player mit dem Computer 
verbunden ist.

2. Klicken Sie auf <My PC> (Mein Computer).

3. Klicken Sie auf <Add Folder> (Ordner hinzufügen) oder <Add File> (Datei
hinzufügen) im unteren Bereich von <EmoDio>.

4. Wählen Sie den gewünschten Ordner bzw. die Datei zum Hinzufügen aus.
Der ausgewählte Ordner oder die Datei wird in der Dateiliste von <EmoDio> 
angezeigt.

5. Wählen Sie aus der Liste von <EmoDio> die zu übertragende Datei aus.

6. Klicken Sie auf das Symbol [  ].
Die ausgewählte Datei wird auf den Player übertragen.

Trennen Sie das USB-Kabel nicht während der Übertragung. Dies kann zu Schäden am 
Player und am PC führen.
Für eine stabile Verbindung ist der direkte Anschluss an den Computer besser als der 
Anschluss über einen USB-Hub.

Klicken Sie für weitere Informationen über <EmoDio> im oberen Bereich des <EmoDio>-
Programms auf <MENU> (Menü)  <Help> (Hilfe)  <Help> (Hilfe).
Das Verfahren zur Musikerkennung und damit verbundene Daten werden von Gracenote und 
dem Gracenote CDDB® Music Recognition ServiceSM zur Verfügung gestellt.
CDDB ist ein eingetragenes Warenzeichen von Gracenote. Das Gracenote-Logo und 
der Logotyp, das Gracenote-CDDB-Logo und der Logotyp sowie das Logo “Powered by 
Gracenote CDDB” sind eingetragene Warenzeichen von Gracenote. Music Recognition 
Service und MRS sind Service-Warenzeichen von Gracenote.

HINWEISE

ACHTUNG
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Videoclip anzeigen
Da eine Dateicodierung nicht nötig ist, können Sie die Datei in Originalqualität 
wiedergeben.

Bevor Sie beginnen - Schalten Sie den Player ein, und überprüfen Sie den Akku.

VIDEOCLIP ANZEIGEN

1. Wählen Sie das Symbol im Hauptmenü.

2. Wählen Sie eine Videodatei zur Wiedergabe aus.
Die ausgewählte Videodatei wird im Querformat wiedergegeben.

Wenn Sie nicht unterstützte Dateiformate mit EmoDio auf den Player übertragen, so wird 
EmoDio sie automatisch in ein Format konvertieren, das auf Ihrem Player wiedergegeben 
werden kann.
Möglicherweise können einige Divx- und wmv-Dateien nicht ordnungsgemäß wiedergegeben 
werden.

HINWEISE



Videoclip anzeigen _ 53

VIDEOWIEDERGABE-BILDSCHIRM
Tippen Sie auf den Bildschirm, wenn Sie Informationen und Symbole zur 
Videowiedergabe anzeigen möchten.

1 Anzeige für DNSe-Modus 6
Wiedergabe-, Pausen- und 
Suchanzeige

2
Bereits wiedergegebene / 
gesamte Spielzeit 7 Dateiname

3 Wiedergabe-Fortschrittsbalken 8 Zurück-Symbol

4 Lesezeichensymbol 9 Menü-Symbol

5
Symbole für Wiedergabe/Pause/
Suche

Die Bildschirmdarstellungen dienen nur zur Veranschaulichung. Die tatsächliche 
Bildschirmanzeige kann von den Abbildungen abweichen.HINWEIS
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TOUCHSYMBOLE ZUR WIEDERGABESTEUERUNG

Tippen Sie drei Sekunden nach Wiedergabestart einmal auf diese Taste, 
um zum Anfang der aktuellen Datei zurückzukehren.
Tippen Sie drei Sekunden nach Wiedergabestart zweimal auf diese 
Taste, um zur vorhergehenden Datei zu springen.
Halten Sie diese Taste gedrückt, um in der aktuellen Datei 
zurückzulaufen.

Tippen Sie auf diese Taste, um die Wiedergabe zu unterbrechen 
(Pause).

Tippen Sie auf diese Taste, um die Wiedergabe fortzusetzen.

Tippen Sie auf diese Taste, um die nächste Datei wiederzugeben.
Halten Sie diese Taste gedrückt, um in der aktuellen Datei vorwärts zu 
laufen.
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KAPITEL ERSTELLEN
Sie können automatisch 5 Kapitel von einem aktuellen Video erstellen. Dann können Sie 
auf ein gewünschtes Kapitel tippen, um direkt an diese Stelle zu springen.

1. Halten Sie während der Videowiedergabe den Finger 
lange auf dem Display.

Die Kapitel werden erstellt.

2. Wählen Sie das gewünschte Kapitel.
Der Player startet ab dem gewählten Kapitel mit der Wiedergabe 
des Videos.

Um zum vorherigen Display zurückzukehren, tippen Sie auf einen Bereich neben den Kapiteln.

BILD SPEICHERN
Sie können während der Videowiedergabe eine Szene aufnehmen und speichern.

1. Stoppen Sie die Videowiedergabe bei der gewünschten 
Szene (mit ).

2. Tippen Sie auf das Symbol [ ].
Die Szene wird unter <File Browser> (Dateibrowser) 
<Pictures> (Bilder)  <Captured> (Aufgenommen) im Format 
bmp gespeichert.
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LESEZEICHEN VERWENDEN

Lesezeichen setzen
Markieren Sie eine Stelle im Videoclip, die Ihnen besonders gefallen hat, mit 
einem Lesezeichen und schauen Sie sie jederzeit wieder an.

1. Tippen Sie während der Wiedergabe auf das 
Symbol [  ], wenn die Stelle erreicht ist, 
die Sie markieren möchten.

2. Wählen Sie <Add Bookmark> (Lesezeichen
hinzufügen).

Die Szene ist nun mit einem Lesezeichen markiert.
Das Symbol [  ] wird im Fortschrittsbalken für die Videowiedergabe eingeblendet.

Für jede Videodatei kann ein Lesezeichen eingestellt werden.

Die Lesezeichenposition kann leicht von der Zielposition abweichen.

Zu einem gesetzten Lesezeichen navigieren/das 
Lesezeichen entfernen

1. Tippen Sie auf das Symbol [  ] auf dem 
Bildschirm für die Videowiedergabe.

2. Wählen Sie <Go to Bookmark > (Zu 
Lesezeichen) oder <Delete Bookmark > 
(Lesezeichen löschen).

Bei Auswahl von <Go to Bookmark > (Zu Lesezeichen) springen Sie zum gewählten 
Lesezeichen. Der Videoclip wird ab dieser Stelle wiedergegeben.
Mit <Delete Bookmark > (Lesezeichen löschen) wird das gewählte Lesezeichen aus 
der Videodatei entfernt.

HINWEISE
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VIDEOMENÜ VERWENDEN

Bevor Sie beginnen - Tippen Sie auf das Symbol [  ] auf dem Bildschirm für die 
Videowiedergabe.

Digital Natural Sound Engine (DNSe) einstellen
Wählen Sie für jedes Videogenre den passenden Sound.

1. Wählen Sie <DNSe>.

2. Wählen Sie die gewünschte DNSe-Option aus.

Was ist DNSe?
DNSe ist die Abkürzung für „Digital Natural Sound Engine“. Hierbei handelt es 
sich um eine von Samsung entwickelte Funktion für spezielle Klangeffekte des 
MP3-Players. Mit dieser Funktion können Sie verschiedene Klangeinstellungen 
je nach Musiktyp festlegen und somit das Hörerlebnis noch intensivieren.

Helligkeit einstellen
Mit dieser Funktion können Sie die Helligkeit des Videobildschirms einstellen.

1. Wählen Sie <Display> <Brightness>
(Helligkeit).

2. Wählen Sie den gewünschten Wert für die 
Helligkeit, und tippen Sie auf <OK>.

Das Menü zur Einstellung der Helligkeit kann nur im Video-Bildschirm aufgerufen 
werden.

HINWEIS

HINWEISE
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VIDEOMENÜ VERWENDEN (Fortsetzung)

Bildschirmgröße auswählen
So können Sie auswählen, in welcher Größe der Videoclip angezeigt werden 
soll:

1. Wählen Sie <Display> <Screen Size> (BS-
Größe).

2. Wählen Sie die gewünschte Bildschirmgröße 
aus.

Menü für Bildschirmgröße

     <Standard>                 <Full> (Voll)                <Zoom> 

Bei einigen Videodateien kann die Displaygröße möglicherweise nicht verändert 
werden.HINWEIS
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VIDEOMENÜ VERWENDEN (Fortsetzung)

Untertitel anzeigen
Sie können ein Video und – falls vorhanden - dessen Untertitel wiedergeben.

1. Wählen Sie <Display> <Subtitle>
(Untertitel) <View> (Anzeige).

2. Tippen Sie auf <On> (Ein) oder <Off> (Aus).
Jedes Mal, wenn Sie auf <On> (Ein) oder <Off> 
(Aus) tippen, wird die Untertitelanzeige ein- bzw. 
ausgeschaltet.

Es werden nur Untertitel im smi-Dateiformat unterstützt.
Der Name der Untertiteldatei sollte mit jenem der wiedergegebenen Videodatei 
übereinstimmen.
- Z. B. Videodatei: Video.avi / Untertiteldatei: Video.smi
Wenn der Untertitel nicht während der Videowiedergabe erscheint, wird das Menü 
<Subtitle> (Untertitel) nicht ausgewählt.

Untertitelsynchronisation anpassen
Wenn die Untertitel zu früh oder zu spät erscheinen, können Sie die 
Synchronisationszeit einstellen, damit Untertitel und Video übereinstimmen.

1. Wählen Sie <Display> <Subtitle>
(Untertitel) <Sync> (Synchr.).

2. Wählen Sie die gewünschte Zeit aus und tippen 
Sie auf <OK>.

Wenn Sie nach Anpassung der Untertitelsynchronisation den Videomodus 
verlassen, muss die Synchronisationszeit neuerlich festgelegt werden.

HINWEISE

HINWEIS
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VIDEOMENÜ VERWENDEN (Fortsetzung)

Horizontale Linie einstellen
Durch Bewegen des Daumens auf dem Touchscreen nach links oder rechts 
können Sie eine Datei in bestimmten Intervallen durchlaufen. Sie können dabei 
eine ganze Datei oder mehrere Sekunden gleichzeitig überspringen.
1. Wählen Sie <Horizontal Stroke> (Horizontale Linie).
2. Wählen Sie die gewünschte Einstellung aus.

Wenn die Option <Seek> (Suchen) eingestellt ist, 
werden Dateien durch die Bewegung Ihres Daumens 
oder Fingers nach links/rechts in den Geschwindigkeiten 
<x2>  <x4>  <x8> wiedergegeben.

Je nach Datei kann das tatsächlich ausgeführte 
Intervall vom eingestellten Sprungintervall abweichen.

Wiedergabegeschwindigkeit einstellen
Sie können die Wiedergabegeschwindigkeit für Ihr Lieblingsvideo schneller oder 
langsamer einstellen.
1. Wählen Sie <Play Speed> 

(Wiedergabegeschwindigkeit).
2. Wählen Sie die gewünschte 

Wiedergabegeschwindigkeit aus und tippen Sie 
auf <OK>.

Für einige Videodateien kann die 
Wiedergabegeschwindigkeit möglicherweise nicht verändert werden.
Die Option <Play Speed> (Wiedergabegeschwindigkeit) ist nicht wählbar, während 
der Player eine Verbindung zu einem Bluetooth-Stereo-Headset herstellt.

Ein Video auf dem Fernsehbildschirm ansehen
Sie können sich das aktuelle Video auf dem Fernsehbildschirm ansehen. 
Weitere Informationen hierzu fi nden Sie auf Seite 38.

HINWEIS

HINWEIS
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Musik wiedergeben
Sie können verschiedene Musikformate wiedergeben.

Bevor Sie beginnen - Schalten Sie den Player ein, und überprüfen Sie den Akku.

KATEGORIE AUSWÄHLEN

1. Wählen Sie das Symbol im Hauptmenü.

2. Wählen Sie aus der Musikliste die gewünschte Position aus.

3. Wählen Sie eine Musikdatei zur Wiedergabe aus.
Die Musikdatei wird abgespielt.
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KATEGORIE AUSWÄHLEN (Fortsetzung)

Musikliste
Je nach dem in der Musikdatei enthaltenen ID3-Tag können Namen von Interpret und Album, 
Musiktitel und Genre angezeigt werden. Eine Datei ohne ID3-Tag wird als [Unknown] (unbekannt) 
angezeigt.

Now Playing (Aktuelle Wiedergabe): Wiedergabe der aktuell gewählten Musikdatei und 
Anzeige von Informationen zur aktuellen Musikdatei.
Artists (Interpret): Wiedergabe nach Interpret.

Albums (Alben): Wiedergabe nach Album. Das Album-Cover-Bild wird angezeigt (soweit 
verfügbar).
Songs (Titel): Wiedergabe der Titel in numerischer bzw. alphabetischer Reihenfolge. 
Für die zuletzt oder gerade wiedergegebene Datei erscheint das Symbol [ ] in der 
rechten Ecke.
Genres (Genre): Wiedergabe nach Musikgenre.

Playlists (Wiedergabelisten): Wiedergabe von Wiedergabelisten.

Recently Added (Zuletzt hinzugefügt): Zeigt 3 Listen mit neu hinzugefügten
Dateien nach Datum sortiert an.

Recorded Files (Aufgenommene Dateien): Zeigt alle aufgenommenen Dateien an.

Music Browser (Musikbrowser): Alle im Musikordner gespeicherten Musikdateien 
werden angezeigt.

Was ist ein ID3-Tag?
Ein ID3-Tag beinhaltet Informationen zum Titel wie z.B. Titelname, Interpret, Albumname, 
Jahr, Genre und einen Kommentar.

HINWEIS
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MUSIKWIEDERGABE-BILDSCHIRM
Tippen Sie auf den Bildschirm, wenn Sie die Symbole zur Musikwiedergabe anzeigen 
möchten.

1
Anzeige für aktuelle Titelnummer / 
Gesamtanzahl der Titel

2 Wiedergabebildschirm

3 Anzeige für Wiedergabemodus

4
Bereits wiedergegebene / gesamte 
Spielzeit

5
Symbole für Wiedergabe/Pause/
Suche

6 A-B-Taste für Bereichswiederholung

7 Menü-Symbol

8
Wiedergabe-, Pausen- und 
Suchanzeige

9 Anzeige für übergeordnetes Menü

10 Musiktitel

11 Wiedergabe-Fortschrittsbalken

12 Anzeige für DNSe-Modus

13 Zurück-Symbol

Die Bildschirmdarstellungen dienen nur zur Veranschaulichung. Die tatsächliche 
Bildschirmanzeige kann von den Abbildungen abweichen.HINWEIS
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TOUCHSYMBOLE ZUR WIEDERGABESTEUERUNG

Tippen Sie drei Sekunden nach Wiedergabestart einmal auf diese 
Taste, um zum Anfang des aktuellen Titels zurückzukehren.
Tippen Sie drei Sekunden nach Wiedergabestart zweimal auf diese 
Taste, um die vorhergehende Datei wiederzugeben.
Halten Sie diese Taste gedrückt, um in der aktuellen Datei 
zurückzulaufen.

Tippen Sie auf diese Taste, um die Wiedergabe zu unterbrechen 
(Pause).

Tippen Sie auf diese Taste, um die Wiedergabe fortzusetzen.

Tippen Sie auf diese Taste, um die nächste Datei wiederzugeben.
Halten Sie diese Taste gedrückt, um in der aktuellen Datei vorwärts zu 
laufen.

Beim Abspielen von VBR-Dateien wird der vorherige Titel möglicherweise nicht 
wiedergegeben, selbst wenn Sie auf [  ] tippen.HINWEIS
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EINE SEQUENZ WIEDERHOLEN
Mit dieser Funktion können Sie bestimmte Stellen eines Titels wiederholt anhören.
Dies ist beispielsweise beim Erlernen einer Sprache hilfreich.

1. Tippen Sie am Anfang der Sequenz, die Sie wiederholen möchten, 
auf das Symbol [  ].

Der Startpunkt wird festgelegt und <A  > wird angezeigt.

2. Tippen Sie am Ende der Sequenz, die Sie wiederholen möchten, 
erneut auf das Symbol [  ].

<A  B> wird angezeigt, und die eingestellte Sequenz wird wiederholt.

Wiederholung abbrechen

Tippen Sie während der Sequenzwiederholung erneut auf das Symbol [  ].
Die Wiederholung der Sequenz wird abgebrochen und die Wiedergabe wird normal 
fortgesetzt.

In folgenden Fällen bricht die Wiederholung automatisch ab:
- Wenn der Startpunkt für die Wiederholung festgelegt wurde, der Endpunkt jedoch nicht vor 

dem Ende des aktuellen Titels liegt;
- Falls der Endpunkt der Wiedergabe weniger als 3 Sekunden vom Startpunkt entfernt liegt.

HINWEIS
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WIEDERGABELISTE AUF DEM MP3-PLAYER ERSTELLEN
Wenn Sie bereits Musikdateien auf den MP3-Player heruntergeladen haben, können Sie 
ohne EmoDio oder Computer eine Wiedergabeliste mit Ihren Favoriten erstellen.

Eine neue Wiedergabeliste hinzufügen

1. Wählen Sie das Symbol im Hauptmenü.

2. Wählen Sie <Playlists> (Wiedergabelisten).

3. Tippen Sie auf das Symbol [  ].

4. Wählen Sie <Add New Playlist> (Neue Wdg.liste hinzuf.).

5. Geben Sie den Namen der Wiedergabeliste ein und tippen 
Sie auf <OK>.

Informationen zur Benutzung der Tastatur fi nden Sie auf Seite 35.

Eine neue Wiedergabeliste wird hinzugefügt.

Zusätzlich zur Standard-Wiedergabeliste 1 können Sie 4 weitere Wiedergabelisten 
im Player erstellen.HINWEIS
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WIEDERGABELISTE AUF DEM MP3-PLAYER ERSTELLEN 
(Fortsetzung)

Namen der Wiedergabeliste bearbeiten

1. Wählen Sie das Symbol  im Hauptmenü.

2. Wählen Sie <Playlists> (Wiedergabelisten).

3. Tippen Sie auf das Symbol [  ].

4. Wählen Sie <Rename> (Umbenennen).

5. Tippen Sie auf [  ] rechts neben der Wiedergabeliste, 
deren Namen Sie ändern möchten.

6. Verändern Sie den Namen der Wiedergabeliste und tippen Sie auf <OK>.
Informationen zur Benutzung der Tastatur fi nden Sie auf Seite 35.

Der Name der Wiedergabeliste wird geändert.

Wiedergabeliste löschen
Führen Sie die oben genannten Schritte 1 – 3 aus.

4. Wählen Sie <Delete> (Löschen).

5. Wählen Sie die gewünschte Wiedergabeliste aus und tippen Sie auf <OK>.
Tippen Sie auf das Symbol [  ], um alle Dateien auszuwählen.

Die Wiedergabeliste 1 kann nicht gelöscht werden.
HINWEIS
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WIEDERGABELISTE AUF DEM MP3-PLAYER ERSTELLEN 
(Fortsetzung)

Eine Datei zur Wiedergabeliste hinzufügen

1. Wählen Sie das Symbol  im Hauptmenü.

2. Wählen Sie <Music Browser> (Musikbrowser).

3. Tippen Sie auf das Symbol [  ].

4. Wählen Sie <Add to Playlist> (In die Wiederg.liste).

5. Wählen Sie die gewünschte Wiedergabeliste aus.

6. Wählen Sie eine Datei zum Hinzufügen aus und tippen Sie 
auf <OK>.

Tippen Sie auf das Symbol [  ], um alle Dateien auszuwählen.

Die ausgewählte Datei wird zur Wiedergabeliste hinzugefügt.

Eine Datei einer Wiedergabeliste wiedergeben

1. Wählen Sie das Symbol  im Hauptmenü.

2. Wählen Sie <Playlists> (Wiedergabelisten).

3. Wählen Sie die gewünschte Wiedergabeliste aus.

4. Wählen Sie eine Musikdatei zur Wiedergabe aus.
Die Musikdatei wird abgespielt.
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WIEDERGABELISTE AUF DEM MP3-PLAYER ERSTELLEN 
(Fortsetzung)

Eine Datei von der Wiedergabeliste entfernen

1. Wählen Sie das Symbol  im Hauptmenü.

2. Wählen Sie <Playlists> (Wiedergabelisten).

3. Wählen Sie die gewünschte Wiedergabeliste aus.

4. Tippen Sie auf das Symbol [ ].
Tippen Sie auf [  ], um der aktuellen Wiedergabeliste eine 
Datei hinzuzufügen.

5. Wählen Sie eine Datei zum Löschen aus und tippen Sie auf 
<OK>.

Tippen Sie auf das Symbol [  ], um alle Dateien 
auszuwählen.

Die ausgewählte Datei wird von der Wiedergabeliste gelöscht.
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MUSIKMENÜ VERWENDEN

Bevor Sie beginnen - Tippen Sie auf das Symbol [  ] auf dem Bildschirm für die 
Musikwiedergabe.

Digital Natural Sound Engine (DNSe) einstellen
Wählen Sie für jedes Musikgenre den passenden Klang aus.

1. Wählen Sie <DNSe>.

2. Wählen Sie die gewünschte DNSe-Option aus.

<Auto> (Automatisch) wählt automatisch den entsprechenden 
DNSe-Modus aus, wenn Informationen zum Musikgenre im ID3-
Tag der Musikdatei enthalten sind.
Sie können die DNSe-Optionen für <myDNSe1> und 
<myDNSe2> unter <Settings> (Einstellungen)  <Sound> (Ton) 

 <myDNSe> einstellen.
Was ist DNSe?
DNSe ist die Abkürzung für „Digital Natural Sound Engine“. 
Hierbei handelt es sich um eine von Samsung entwickelte 
Funktion für spezielle Klangeffekte des MP3-Players. Mit dieser 
Funktion können Sie verschiedene Klangeinstellungen je nach Musiktyp festlegen 
und somit das Hörerlebnis noch intensivieren.

HINWEISE
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MUSIKMENÜ VERWENDEN (Fortsetzung)

Wiedergabemodus einstellen
Für den Wiedergabemodus stehen mehrere Optionen zur Auswahl.

1. Wählen Sie <Play Mode> (Wiedergabemodus).

2. Wählen Sie den gewünschten Wiedergabemodus aus.

Optionen für den Wiedergabemodus
Normal: Spielt alle Dateien der aktuellen Kategorie einmal in 
der gelisteten Reihenfolge ab.
Repeat (Wiederholen): Wiederholt alle Dateien der aktuellen 
Kategorie.
Repeat One (1 Tit. wiederh.): Wiederholt eine Datei.
Shuffl e (Zuf.wiederg.): Wiederholt alle Dateien der aktuellen 
Kategorie in zufälliger Reihenfolge.
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MUSIKMENÜ VERWENDEN (Fortsetzung)

Bildschirm für die Musikwiedergabe einstellen
Wählen Sie ein Hintergrundbild aus, das während der Musikwiedergabe 
angezeigt werden soll.

1. Wählen Sie <Music Play Screen> (Wiederg.bildschirm).

2. Wählen Sie das gewünschte Hintergrundbild für die 
Musikwiedergabe aus und tippen Sie auf <OK>.

Optionen für den Wiedergabebildschirm
Album Art (Alb.-Cover): Ein Album-Cover wird angezeigt, 
wenn die entsprechende Information im ID3-Tag der Musikdatei 
enthalten ist.
Beim Album-Cover werden Bilder mit weniger als 2 MB 
unterstützt.
Spectrum (Spektrum), Passionate (Leidenschaftlich), Sweet 
(Verliebt), Quiet (Ruhig), Cheerful (Fröhlich): Sie können 
verschiedene bewegliche Bilder als Hintergrundbild auswählen, 
während Musik wiedergegeben wird.

Was ist ein ID3-Tag?
Ein ID3-Tag beinhaltet Informationen zum Titel wie z.B. Titelname, Interpret, 
Albumname, Jahr, Genre und einen Kommentar.

HINWEIS
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MUSIKMENÜ VERWENDEN (Fortsetzung)

Horizontale Linie einstellen
Sie können das Intervall festlegen, in dem Sie in einer Musikdatei durch 
horizontales Bewegen des Daumens oder Fingers vor- oder zurückblättern 
möchten.

1. Wählen Sie <Horizontal Stroke> (Horizontale Linie).

2. Wählen Sie die gewünschte Einstellung aus.
Wählen Sie zwischen <1 Song> (1 Titel), <5sec Skip> (5-
Sek-Sprung), <10sec Skip> (10-Sek-Sprung), <30sec Skip> 
(30-Sek-Sprung) und <1min Skip> (1-Min-Sprung). Somit wird die 
Wiedergabezeit festgelegt, die übersprungen wird, wenn Sie Ihren
Finger während der Wiedergabe einer Musikdatei über das Display 
bewegen.

Das Sprungintervall kann sich – abhängig von der Datei - vom 
tatsächlichen Intervall unterscheiden.

Aktuelle Musikdatei zur Wiedergabeliste hinzufügen
Sie können den aktuell wiedergegebenen Titel zu einer Wiedergabeliste 
hinzufügen.

1. Wählen Sie <Add to Playlist> (In die Wiederg.liste).

2. Wählen Sie die gewünschte Wiedergabeliste aus.
Der aktuelle Titel wird zur Wiedergabeliste hinzugefügt.

HINWEIS
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MUSIKMENÜ VERWENDEN (Fortsetzung)

Alarmton hinzufügen
Sie können Ihre Lieblingsmusik in die Liste der Alarmmelodien aufnehmen und 
diese beim nächsten Alarm wiedergeben lassen. Informationen zum Einstellen 
des Alarms fi nden Sie auf Seite 118.

1. Wählen Sie <Add to Alarm> (Zu Alarm hinzufügen).

2. Wählen Sie <Yes> (Ja).
Die aktuelle Musik wird der Liste der Alarmmelodien 
hinzugefügt.

Es können maximal 3 Musikdateien zum Alarmton hinzugefügt 
werden.

Wiedergabegeschwindigkeit einstellen
Sie können die Wiedergabegeschwindigkeit für Ihre Lieblingsmusik schneller 
oder langsamer einstellen.

1. Wählen Sie <Play Speed> (Wiedergabegeschwindigkeit).

2. Wählen Sie die gewünschte Wiedergabegeschwindigkeit 
aus und tippen Sie auf <OK>.

Die Option <Play Speed> (Wiedergabegeschwindigkeit) ist 
nicht verfügbar, während der Player eine Verbindung zu einem 
Bluetooth-Stereo-Headset herstellt.

HINWEIS

HINWEIS
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Bilder anzeigen
Sie können ein Bild vergrößern oder ein bestimmtes Bild als Hintergrundbild 
einstellen.

Bevor Sie beginnen - Schalten Sie den Player ein, und überprüfen Sie den Akku.

BILDER ANZEIGEN

1. Wählen Sie das Symbol im Hauptmenü.

2. Wählen Sie die gewünschte Bilddatei aus.
<Skin> (Design) ist der Ordner, in dem die als Hintergrundbild festgelegten 
Bilder gespeichert werden. Siehe Seite 78.

<Captured> (Screenshots) ist der Ordner, in dem die im Videomodus 
erstellten Screenshots gespeichert werden. Siehe Seite 55.

Zum vorherigen/nächsten Bild blättern

Tippen Sie auf das Symbol [  ,  ] auf dem 
Wiedergabebildschirm.

Bei Anzeige im Querformat tippen Sie auf das Symbol 
[  ,  ].

[  ] wird angezeigt, falls die Bilddateien fehlerhafte Miniaturbilddaten 
enthalten.
Manche Bilder werden möglicherweise verzögert angezeigt.

HINWEISE
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BILDER VERGRÖSSERN
Sie können ein Bild heranzoomen.

1. Tippen Sie auf das Symbol [  ] auf dem 
Wiedergabebildschirm.

Die Zoomleiste erscheint.

2. Verwenden Sie die Zoomleiste, um das Bild zu vergrößern.

Um die Bildvergrößerung abzubrechen, tippen Sie einmal auf den 
Touchscreen, und tippen Sie auf das Symbol [  ].

Vergrößertes Bild anzeigen
Bewegen Sie Ihren Finger auf dem Bildbereich, der vergrößert wurde.

DIASHOW ANZEIGEN
Sie können die Bilder in einer Diashow wiedergeben.

Tippen Sie auf das Symbol [  ] auf dem Wiedergabebildschirm.
Die Diashow wird gestartet.

Sie können die Diashow ebenfalls im Modus Bildvorschau starten.

Diashow anhalten

Tippen Sie im Diashow-Modus auf den Touchscreen.

HINWEIS

HINWEIS
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BILDMENÜ VERWENDEN
Bevor Sie beginnen - Tippen Sie auf das Symbol [  ] auf dem Wiedergabebildschirm.

Effekt für Diashow einstellen
Sie können den Übergangseffekt einstellen, d. h. die Art, wie ein Bild während 
einer Diashow zum Nächsten wechselt.

1. Wählen Sie <Slideshow Effect> (Diashow-Effekt).

2. Wählen Sie den gewünschten Diashow-Effekt aus und 
tippen Sie auf <OK>.

Ein Bild drehen
Sie können Bilder nach Belieben drehen.

1. Wählen Sie <Rotate> (Drehen).

2. Wählen Sie den gewünschten Drehwinkel aus.
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BILDMENÜ VERWENDEN (Fortsetzung)
Bevor Sie beginnen - Wählen Sie ein Bild aus und tippen Sie auf das Symbol 
[  ] auf dem Wiedergabebildschirm.

Foto als Bildschirmhintergrund auswählen
Sie können ein Foto als Bildschirmhintergrund auswählen.

1. Wählen Sie <Assign> (Zuweisen) <My Skin> (Mein 
Design).

2. Wählen Sie <Yes> (Ja).
Das ausgewählte Bild wird als Bildschirmhintergrund verwendet.

Bilddatei als Startbild auswählen
Sie können festlegen, dass das gewünschte Bild beim Starten des Geräts 
angezeigt wird.

1. Wählen Sie <Assign> (Zuweisen) <Booting Image> (Startbild).

2. Wählen Sie <Yes> (Ja).
Die ausgewählte Bilddatei wird als Startbild verwendet.
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BILDMENÜ VERWENDEN (Fortsetzung)

Ein Bild auf ein Bluetooth-Gerät übertragen
Sie können Bilddateien auf externe Geräte übertragen, die mit Bluetooth 
kompatibel sind.

1. Wählen Sie <Send> (Senden).

2. Wählen Sie das gewünschte Bluetooth-Gerät.
Wenn sich das gewünschte Bluetooth-Gerät nicht in der Liste 
befi ndet, tippen Sie auf das Symbol [ ], um nach neuen 
Geräten zu suchen. Informationen dazu fi nden Sie auf Seite 106.

3. Bestätigen Sie die Verbindung mit dem externen Bluetooth-
Gerät.

Die ausgewählte Bilddatei wird auf das externe Bluetooth-Gerät übertragen.

Ein Bild auf dem Fernsehbildschirm ansehen
Sie können sich eine Bilddatei auf dem Fernsehbildschirm ansehen. Weitere 
Informationen hierzu fi nden Sie auf Seite 38.
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Texte anzeigen
Ob ein Roman, das Manuskript einer neuen Geschichte oder Ihre 
Forschungsarbeit – mit dem MP3-Player können Sie Texte lesen und 
dabei gleichzeitig Musik hören!

Bevor Sie beginnen - Schalten Sie den Player ein, und überprüfen Sie den Akku.
Unter <Settings> (Einstellg.)  <Language> (Sprache) <Contents> (Inhalt) können Sie 
die gewünschte Sprache für den Text einstellen. Informationen dazu fi nden Sie auf Seite 43.

TEXTE ANZEIGEN
1. Wählen Sie das Symbol  im Hauptmenü.

2. Wählen Sie die gewünschte Textdatei aus.
Die Textdatei wird als Vollbild angezeigt.

Tippen Sie auf den Bildschirm, wenn Sie Informationen und Symbole zu den 
Texten anzeigen wollen.

Zur vorherigen/nächsten Seite blättern

Führen Sie eine horizontale Bewegung auf dem Textanzeigebildschirm aus.
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LESEZEICHEN VERWENDEN

Lesezeichen setzen
Setzen Sie ein Lesezeichen an eine Stelle im Text, damit Sie jederzeit schnell 
zu dieser Stelle zurückkehren können.

1. Tippen Sie während der Textanzeige bei der gewünschten 
Seite auf das Symbol [  ] .

2. Wählen Sie <Add Bookmark> (Lesezeichen hinzufügen).
Die aktuelle Seite wird mit einem Lesezeichen versehen und das 
Symbol [  ] erscheint im oberen Bereich des Vollbildmodus.

Für jede Textdatei kann ein Lesezeichen eingestellt werden.

Zum Lesezeichen gelangen oder das Lesezeichen entfernen

1. Tippen Sie auf das Symbol [  ] unten im 
Textanzeigebildschirm.

2. Wählen Sie <Go to Bookmark> (Zu Lesezeichen) oder 
<Delete Bookmark> (Lesezeichen löschen).

Bei Auswahl von <Go to Bookmark> (Zu Lesezeichen) gelangen 
Sie an die Stelle, an der das Lesezeichen gesetzt wurde. Bei 
Auswahl von <Delete Bookmark> (Lesezeichen löschen) wird das 
ausgewählte Lesezeichen aus der Textdatei entfernt.

HINWEIS
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TEXTMENÜ VERWENDEN
Bevor Sie beginnen - Tippen Sie auf das Symbol [  ] auf dem Textanzeigebildschirm.

Textbetrachtertyp einstellen
Wählen Sie die Art, in der der Text angezeigt werden soll.

1. Wählen Sie <Text Viewer Type> (Textbetrachtertyp).

2. Wählen Sie die gewünschte Einstellung aus und tippen Sie 
auf <OK>.

Schriftgröße ändern
Sie können die Schriftgröße des Texts ändern.

1. Wählen Sie <Font Size> (Schriftgröße).

2. Wählen Sie die gewünschte Schriftgröße aus.
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Externe Speicherkarte verwenden
Ihr Player verfügt über einen eingebauten Speicherkartensteckplatz, der mit 
MicroSDTM- und MicroSDHCTM-Karten kompatibel ist, die vor allem dazu 
verwendet werden, Dateien und Daten zu speichern oder zu übertragen.

Bevor Sie beginnen - Die externe Speicherkarte ist optional.

EXTERNE SPEICHERKARTE EINLEGEN
Schieben Sie die Speicherkarte mit der Vorderseite nach 
oben ein, bis Sie ein Klicken hören. Dies bedeutet, dass 
die Karte richtig eingelegt wurde.

EXTERNE SPEICHERKARTE 
ENTFERNEN
Drücken Sie sanft auf das herausstehende Ende der 
Karte.

Die Speicherkarte wird aus dem Steckplatz ausgegeben.

Entfernen Sie die Karte nicht, während Sie sie verwenden. 
Dies kann sowohl die Karte und den Player, als auch 
gespeicherte Daten beschädigen.
Für den Player eignen sich MicroSD- oder MicroSDHC-
Karten bis zu 8 GB. (Wenn Sie eine Speicherkarte verwenden, die nicht kompatibel ist, so 
kann diese beschädigt oder möglicherweise nicht mehr entfernt werden; der Player kann 
solche Karten nicht erkennen.)
Achten Sie darauf, Speicherkarten stets richtig herum einzusetzen.
Fertigen Sie von wichtigen Daten immer Sicherheitskopien an. Samsung haftet nicht für 
Datenverlust aufgrund von beschädigten Speicherkarten.

ACHTUNG



84 _ Externe Speicherkarte verwenden

EINE DATEI AUF DER EXTERNEN SPEICHERKARTE 
WIEDERGEBEN
Sie können Bilder, Videos, Text- und Musikdateien, die sich auf der externen 
Speicherkarte befi nden, direkt mit dem Player wiedergeben.

1. Wählen Sie das Symbol  im Hauptmenü.

2. Wählen Sie einen Ordner aus, um dessen Dateiliste anzuzeigen.

3. Wählen Sie eine Datei aus.
Die Datei wird abgespielt.

-Symbol: Videodatei
-Symbol: Musikdatei
-Symbol: Bilddatei
-Symbol: Textdatei

Sie können keine Dateiformate wiedergeben, die nicht von dem Player unterstützt werden.

Einige Menüoptionen sind deaktiviert, während Sie eine Datei auf der Speicherkarte 
wiedergeben.

HINWEIS

ACHTUNG
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EINE DATEI VON DER SPEICHERKARTE AUF DEN PLAYER 
ÜBERTRAGEN
Sie können eine Datei von der Speicherkarte auf den Player übertragen.

1. Wählen Sie das Symbol  im Hauptmenü.

2. Wählen Sie einen Ordner aus, um dessen Dateiliste anzuzeigen.

3. Tippen Sie auf das Symbol [  ].

4. Wählen Sie <Copy> (Kopieren)

5. Wählen Sie eine Datei aus und tippen Sie auf <OK>.
Tippen Sie auf das Symbol [  ], um alle Dateien auszuwählen.

6. Wählen Sie <Yes> (Ja).
Die ausgewählte Datei wird auf den Player übertragen.
Um die Übertragung abzubrechen, tippen Sie auf <Cancel> (Abbrechen).

Dateien, die von der Speicherkarte übertragen wurden, befi nden sich unter <File Browser> 
(Dateibrowser)  <Shared Data> (Gemeinsame Daten).HINWEIS
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EINE DATEI AUF DER EXTERNEN SPEICHERKARTE 
LÖSCHEN
Sie können eine Datei von der Speicherkarte löschen.

1. Wählen Sie das Symbol  im Hauptmenü.

2. Wählen Sie einen Ordner aus, um dessen Dateiliste anzuzeigen.

3. Tippen Sie auf das Symbol [  ].

4. Wählen Sie <Delete> (Löschen).

5. Wählen Sie eine Datei aus und tippen Sie auf <OK>.
Tippen Sie auf das Symbol [  ], um alle Dateien auszuwählen.

6. Wählen Sie <Yes> (Ja).
Die ausgewählte Datei wird von der Speicherkarte gelöscht.
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EINE DATEI VOM PLAYER AUF DIE SPEICHERKARTE 
ÜBERTRAGEN
Sie können eine Datei vom Player auf die Speicherkarte übertragen.

1. Wählen Sie das Symbol  im Hauptmenü.

2. Wählen Sie einen Ordner aus, um dessen Dateiliste anzuzeigen.

3. Tippen Sie auf das Symbol [  ].

4. Wählen Sie <Copy to microSD card> (Auf SD-Karte kopieren).

5. Wählen Sie eine Datei aus und tippen Sie auf <OK>.
Tippen Sie auf das Symbol [  ], um alle Dateien auszuwählen.

6. Wählen Sie <Yes> (Ja).
Die ausgewählte Datei wird auf die Speicherkarte übertragen.

Vom Player übertragene Dateien werden auf der Speicherkarte im Ordner <Shared Data> 
(Gemeinsame Daten) gespeichert.HINWEIS
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UKW-Radio verwenden
Sie können ein UKW-Radioprogramm hören oder aufnehmen.

Bevor Sie beginnen - Schließen Sie die Ohrhörer an, schalten Sie den Player ein, und 
überprüfen Sie den Akku.

UKW-RADIO VERWENDEN

Wählen Sie das Symbol im Hauptmenü.
Der UKW-Radioempfang wird aktiviert.

Stummfunktion verwenden

1. Tippen Sie bei eingeschaltetem Radio auf das Symbol [  ].

Tippen Sie das Symbol [  ] erneut an, um den Ton wieder zu aktivieren.

Schließen Sie zur Sendersuche, zum Einstellen von Sendern oder beim Radiohören immer 
die Ohrhörer an den Player an.
Die Ohrhörer dienen gleichzeitig als Antenne für den UKW-Radioempfang. 
In Gegenden mit schlechtem Empfang fi ndet der Player unter Umständen keine Sender.

ACHTUNG

News
Today Headline
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UKW-RADIO-BILDSCHIRM

1
Symbol für den manuellen 
Sendereinstellmodus 8 Symbol für niedrigere Frequenz

2 Symbol für höhere Frequenz 9 Stumm-Symbol
3 Aktuelle Frequenz (MHz) 10 Position auf der Frequenzskala
4 RDS-Anzeige 11 Sendersuchelement
5 Menü-Symbol 12 Zurück-Symbol
6 Aufnahmetaste 13 Symbol für gespeicherte Sender

7
Symbol für den Modus für 
gespeicherte Sender

Was ist RDS?
RDS (Radio Data System) ermöglicht den Empfang und das Anzeigen von 
Senderinformationen. Informationen zum Programm, zu Nachrichten, Sport, Musik oder zum 
Radiosender werden auf dem Display angezeigt.
Falls das UKW-Radiosignal schwach ist, kann die RDS-Information gegebenenfalls nicht 
angezeigt werden.
RDS steht nur in bestimmten europäischen Regionen zur Verfügung.
Die Bildschirmdarstellungen dienen nur zur Veranschaulichung. Die tatsächliche 
Bildschirmanzeige kann von den Abbildungen abweichen.

HINWEISE

News
Today Headline
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UKW-SENDER EINSTELLEN
Halten Sie im manuellen Sendereinstellmodus das Symbol [ , ] kurz 
gedrückt.

Der Suchvorgang stoppt bei der Senderfrequenz, die nach Freigeben des 
Symbols am nächsten liegt.

oder:

Tippen Sie auf das Symbol [ , ], um im manuellen 
Sendereinstellmodus in Schritten von 0,05 MHz durch die 
Frequenzen zu laufen.

Durch Antippen des Symbols wird die Frequenz um jeweils 
0,05 MHz erhöht oder verringert.

oder:

Drehen Sie das Sendersuchelement im manuellen Modus mit dem Finger, als würden 
Sie einen Kreis zeichnen.

News
Today Headline
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UKW-RADIOSENDUNGEN AUFNEHMEN

UKW-Radioaufnahmen erstellen
Sie können beim Hören von Radiosendungen jederzeit eine UKW-
Radioaufnahme erstellen.

Stellen Sie den Radiosender ein, von dem Sie aufnehmen 
möchten, und tippen Sie auf das Symbol [  ].

Die Aufnahme wird gestartet.

Aufnahme beenden

1. Tippen Sie während der Aufnahme auf das Symbol
[  ].

Es wird eine Meldung angezeigt, in der Sie gefragt werden, ob 
Sie die aufgenommene Datei wiedergeben möchten.

2. Wählen Sie <Yes> (Ja) oder <No> (Nein).
Bei <Yes> (Ja) startet die Wiedergabe der aufgenommenen Datei.
Bei <No> (Nein) wird die aufgenommene Datei nicht 
wiedergegeben.

Tippen Sie auf das Symbol [  ], um die Aufnahme auf Pause zu stellen.
Die aufgenommene Datei wird im <File Browser> (Dateibrowser) unter 
<Recorded Files> (Aufgenommene Dateien)  <FM Radio> (UKW-Radio) 
gespeichert.
Jede Aufnahmedatei kann eine Länge von bis zu 5 Stunden haben.

HINWEISE

News
Today Headline

News
Today Headline
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ZWISCHEN DEM MODUS FÜR GESPEICHERTE SENDER 
UND DEM SENDEREINSTELLMODUS UMSCHALTEN

Modus für gespeicherte Sender aufrufen
Wählen Sie diesen Modus, um einen der bereits gespeicherten UKW-Sender 
aufzurufen.

Tippen Sie im manuellen Modus auf [  ].

Wenn keine Sender gespeichert sind, wechselt der Player nicht 
in den <Preset Mode> (Modus für gesp. Sender).

Manuellen Sendereinstellmodus aufrufen
Wählen Sie diesen Modus, um eine Senderfrequenz im UKW-Bereich manuell 
einzustellen.

Tippen Sie im Modus für voreingestellte Sender auf [  ].

HINWEIS

News
Today Headline

News
Today Headline
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UKW-RADIOMENÜ VERWENDEN

Sender speichern
Sie können bis zu 30 Sender auf Ihrem MP3-Player speichern und durch Tippen 
auf ein Symbol abrufen.

Manuell – nur ausgewählte Sender speichern:

1. Stellen Sie im manuellen Sendereinstellmodus einen 
Sender ein, den Sie speichern möchten. Drücken Sie 
anschließend auf das Symbol [  ].

2. Wählen Sie <Add to Preset> (Sender speichern).
Der ausgewählte Sender wird unter dem nächsten freien 
Speicherplatz gespeichert.

Automatisch – alle vom Player empfangenen Sender automatisch speichern:

1. Tippen Sie auf das Symbol [  ] auf dem Bildschirm 
für UKW-Radio.

2. Wählen Sie <Auto Preset> (Autom. Sendersp.).

3. Wählen Sie <Yes> (Ja).

Automatische Senderspeicherung abbrechen
Um die automatische Senderspeicherung abzubrechen, 
tippen Sie auf das Symbol [  ].

Die automatische Senderspeicherung wird abgebrochen, und nur die bis dahin 
eingestellten Sender werden gespeichert.

News
Today Headline
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UKW-RADIOMENÜ VERWENDEN (Fortsetzung)

Gespeicherte Sender aufrufen
Wählen Sie den gewünschten Sender im Modus für 
gespeicherte Sender.

Der gespeicherte Radiosender wird aufgerufen.

Sender löschen
Sie können einen gespeicherten Sender aus der Liste der gespeicherten
Sender entfernen.

1. Tippen Sie im Modus für gespeicherte Sender auf das 
Symbol [  ].

2. Wählen Sie <Delete from Preset> (Sender löschen).

3. Wählen Sie einen Sender zum Löschen aus und tippen Sie 
auf <OK>.

Tippen Sie auf das Symbol [  ], um alle gespeicherten
Sender auszuwählen.

4. Wählen Sie <Yes> (Ja).
Der ausgewählte Sender wird gelöscht.

News
Today Headline

News
Today Headline
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UKW-RADIOMENÜ VERWENDEN (Fortsetzung)

UKW-Bereich einstellen
Vor einer Reise ins Ausland können Sie den UKW-Bereich ändern.

1. Tippen Sie auf das Symbol [  ] auf dem Bildschirm 
für UKW-Radio.

2. Wählen Sie <FM Region> (UKW-Bereich).

3. Wählen Sie den gewünschten UKW-Bereich aus.
Frequenzbereich nach Region 

Worldwide
(weltweit)

Suche nach Sendern zwischen 87,50 MHz und 
108,00 MHz in 50 kHz-Schritten.

USA Suche nach Sendern im Bereich von 87,5 MHz
bis 108,0 MHz in Schritten von 100 kHz.Korea

Japan Suche nach Sendern im Bereich von 76,0 MHz
bis 108,0 MHz in Schritten von 100 kHz.

4. Wählen Sie <Yes> (Ja) oder <No> (Nein).
Wählen Sie <Yes> (Ja), um automatisch alle Sender des gewählten Bereichs zu 
suchen und speichern; wählen Sie <No>, um nur den Bereich zu ändern.

Wenn Sie die Einstellung für <FM Region> (UKW-Bereich) des Players ändern, 
werden die gespeicherten Radiosender gelöscht.
Der UKW-Bereich kann je nach Aufenthaltsort geändert werden.

HINWEISE

News
Today Headline
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Videospiele spielen
Auf Ihrem MP3-Player stehen für Sie spannende Spiele bereit!

VIDEOSPIELE SPIELEN

1. Wählen Sie das Symbol  im Hauptmenü.

2. Wählen Sie ein Spiel aus.

Spiele können ohne vorherige Ankündigung hinzugefügt oder geändert werden.
Ausführlichere Informationen fi nden Sie im Hilfeabschnitt des jeweiligen Spiels.HINWEISE
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VIDEOSPIELE SPIELEN (Fortsetzung)

AstroRanger
Dies ist ein Rhythmusspiel, bei dem Sie Punkte gewinnen können, indem 
Sie auf ein Objekt tippen, das entsprechend der ausgewählten Musik in den 
Zielbereich gelangt.

Wählen Sie die Musik, den Schwierigkeitsgrad und den 
Tastentyp, wenn Sie das Spiel starten.

Sie erhalten mehr Punkte, wenn Sie im Shop einkaufen.

Bubble Bang
Sie müssen Punkte sammeln, indem Sie in einer bestimmten Zeit so viele 
Blasen wie möglich zum Platzen bringen.

Tippen Sie auf die Blase oder gleiten Sie mit dem Finger 
darüber, um sie zum Platzen zu bringen.



98 _ Videospiele spielen

VIDEOSPIELE SPIELEN (Fortsetzung)

Omok2
Um dieses strategische Brettspiel zu gewinnen, bilden Sie eine 
durchgehende Reihe aus fünf Spielsteinen in horizontaler, vertikaler oder 
diagonaler Richtung, bevor es der Gegner schafft.

Tippen Sie auf den Bereich, in dem Sie Ihren Stein 
ablegen möchten, damit dieser Bereich vergrößert 
wird.
Tippen Sie in der vergrößerten Ansicht exakt auf die 
Position, an der Sie Ihren Stein ablegen möchten.

Wenn Sie nicht innerhalb der Spielzeit Ihren Zug 
beendet haben, ist der Gegner an der Reihe.

Um das Spiel abzubrechen, tippen Sie auf die untere linke Ecke des Touchscreens.
HINWEIS
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VIDEOSPIELE SPIELEN (Fortsetzung)

Omok mit 2 Personen im Bluetooth-Modus spielen

Bevor Sie beginnen - Wenn einer der Spieler mit einem Bluetooth-Stereo-
Headset, Handy oder externen Gerät verbunden ist, trennen Sie zuerst diese 
Verbindung.
Aktivieren Sie den Bluetooth-Modus der Spieler. Informationen dazu fi nden Sie auf 
Seite 103.

1. Starten Sie <Omok2> auf zwei YP-M1-
Modellen und wählen Sie den Modus 
<Double> (2 Spieler).

2. Wählen Sie auf einem Gerät die Option 
<Wait> (Warten) und auf dem anderen Gerät 
die Option <Connect> (Verbinden).

YP-M1 erscheint auf dem YP-M1, auf dem 
<Connect> (Verbinden) ausgewählt wurde.

3. Wählen Sie <YP-M1>.
Die Bluetooth-Verbindung wird hergestellt und 
das Duell startet.
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VIDEOSPIELE SPIELEN (Fortsetzung)

PowWow
Dies ist ein Schießspiel, in dem Sie durch Abschießen des beweglichen Ziels 
Punkte erhalten.

Tippen Sie auf das bewegliche Ziel.

Zum Nachladen der Waffe tippen Sie auf dem Touchscreen auf 
<Reload> (Nachladen).

WiseStar
Dies ist ein Puzzlespiel, in dem Sie Weltraumbereiche gewinnen können, 
indem Sie 3 Planeten in einer horizontalen oder vertikalen Reihe 
nebeneinandersetzen. Diese explodieren dann und die Hintergrundfarbe ändert 
sich.

Wählen Sie einen Planeten und tauschen Sie ihn gegen einen 
Planeten in der Umgebung aus.

Die Planeten [ ], [ ], [ ] und [ ] sind Bonusobjekte, mit 
denen Sie umliegende Planeten explodieren lassen können, 
indem Sie zwei Mal auf [  ] tippen.
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VIDEOSPIELE SPIELEN (Fortsetzung)

Sudoku Champ
Bei diesem Denkspiel müssen die Zahlen von 1 bis 9 in jedes 3 × 3-Quadrat 
sowie in jede Reihe und Spalte des 9 × 9-Gitters eingegeben werden.

Wählen Sie ein leeres Feld, und geben Sie eine Zahl von 1 bis 
9 mithilfe des unteren Zahlenfeldes ein. Sie können jede Zahl 
nur jeweils einmal pro Feld, Quadrat und Gitter verwenden.

Drücken Sie auf <Memo> (Notizen), wenn Sie sich mehr als eine 
Zahl für das leere Feld vormerken möchten.

Drücken Sie auf <Menu> (Menü)  <Hint> (Hinweis), um die 
richtige Zahl für das Feld anzuzeigen.

Drücken Sie auf <Menu> (Menü)  <Checkup> (Kontrolle), um 
zu überprüfen, in welches Feld eine falsche Zahl eingegeben 
wurde.
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Bluetooth verwenden
Über Bluetooth können Sie Ihren Player mit anderen Bluetooth-fähigen Geräten 
verbinden, mit diesen Daten austauschen, beim Telefonieren freisprechen oder 
mit einem Bluetooth-Stereo-Headset Musik hören.

 ALLGEMEINES ZU BLUETOOTH
Je nach den Bedingungen, unter denen das Bluetooth-Gerät verwendet wird, 
können Nebengeräusche oder Fehlfunktionen auftreten.

Beispielsweise können physische Störungen des Signals auftreten, wenn Sie den Player in 
der Hand halten und gleichzeitig ein Stereo-Headset tragen.
Störungen können auch auftreten bei Kontakt eines Körperteils mit dem Empfänger/Sender 
des Players oder des Stereo-Headsets.
Sende-/Empfangsprobleme können aufgrund von Wänden, Ecken oder Bürotrennwänden 
entstehen.
Elektrische Störungen können auch durch Geräte, die im gleichen Frequenzband arbeiten, 
z. B. medizinische Geräte, Mikrowellen und WLAN-Geräte verursacht werden.

Der Abstand zwischen Bluetooth-Gerät und Player sollte besonders beim Koppeln 
möglichst gering sein.
Je größer der Abstand zwischen Player und Headset, desto schlechter die 
Qualität. Die Verbindung wird unterbrochen, wenn die Entfernung die Reichweite 
überschreitet.
Wir empfehlen, den Text- und Bildanzeigemodus nicht zu verwenden, während 
Sie mit dem Stereo-Headset Musik hören. Dies kann sowohl zu einer schlechteren 
Leistung des Players als auch der Bluetooth-Verbindung führen.
An Orten mit schlechtem Empfang (z. B. in Aufzügen oder U-Bahnen) funktioniert 
die Bluetooth-Verbindung möglicherweise nicht einwandfrei.
Die maximale Entfernung für die drahtlose Verbindung zwischen dem Player und 
anderen Bluetooth-Geräten beträgt 10 m. Bei Überschreiten dieser Entfernung wird 
die Verbindung automatisch getrennt. Auch innerhalb dieses Bereichs kann die 
Klangqualität durch Objekte wie Wände oder Türen beeinträchtigt werden.
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HINWEISE

BLUETOOTH-EINSTELLUNGEN
Überprüfen Sie die Bluetooth-Einstellungen des Players, bevor Sie diese Funktion 
verwenden.

Bevor Sie beginnen - Wählen Sie das Symbol  im Hauptmenü.

Bluetooth-Modus aktivieren
Sie müssen den Bluetooth-Modus aktivieren, wenn Sie den Player mit einem 
externen Bluetooth-Gerät verbinden möchten.

Tippen Sie auf das Symbol [  ].
Wenn der Bluetooth-Modus aktiviert ist, wechselt die Anzeige zu dem 
Symbol [ ]. Außerdem wird das Symbol [ ] angezeigt.

Wenn Sie die Funktion nicht verwenden, stellen Sie <My Info> (Meine 
Info)  <Bluetooth> auf <Off> (Aus). Wenn Sie die Funktion <Bluetooth> 
auf <On> (Ein) gestellt lassen, wird mehr Akkuenergie verbraucht.

Die Bluetooth-Funktionen des Players wurden für Samsung-Produkte 
optimiert. Wenn Produkte von Drittanbietern verwendet werden, kann dies die Bluetooth-
Funktionen beeinträchtigen.

Beschreibung der Bluetooth-Symbole
: Bluetooth-Modus eingeschaltet
: Mit Stereo-Headset verbunden : Mit Mobiltelefon verbunden

Missbrauchen Sie die Bluetooth-Funktion nicht für illegale Aktivitäten (wie z. B. die 
Anfertigung von Raubkopien oder illegale Mitbenutzung von drahtlosen Verbindungen für 
gewerbliche Zwecke).
Samsung übernimmt keine Verantwortung für die illegale Nutzung dieser Funktion und 
eventuell daraus resultierende Konsequenzen.

ACHTUNG
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BLUETOOTH-EINSTELLUNGEN (Fortsetzung)

Bevor Sie beginnen - Tippen Sie auf [ ] und anschließend auf [  ].

Bluetooth-Modus deaktivieren

1. Wählen Sie <My Info> (Meine Info).

2. Tippen Sie auf [  ] neben dem Bluetooth-Symbol.
Die Anzeige wechselt zu dem Symbol [  ] und das Symbol 
[ ] wird ausgeblendet.

Bluetooth-Gerät umbenennen
Sie können ein Bluetooth-Gerät in der Geräteliste umbenennen.

1. Wählen Sie <My Info> (Meine Info).

2. Tippen Sie auf das Eingabefeld in der Mitte.

3. Benennen Sie das Gerät um.
Informationen zur Benutzung der Tastatur fi nden Sie auf Seite 35.
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VERBINDUNG MIT EINEM BLUETOOTH-GERÄT HERSTELLEN
Wenn Sie die Funktion Bluetooth verwenden möchten, suchen Sie nach einem 
Bluetooth-Gerät und stellen Sie eine Verbindung zu Ihrem Player her. 

Bevor Sie beginnen - Aktivieren Sie zuerst den Bluetooth-Modus des Players.
Aktivieren Sie den Bluetooth-Modus ebenfalls auf dem gewünschten Bluetooth-Gerät. 
(Weitere Informationen dazu fi nden Sie im Benutzerhandbuch des Bluetooth-Geräts.)
Wenn der Player bereits mit einem Bluetooth-Gerät verbunden ist, trennen Sie diese 
Verbindung zuerst.

Suchoption einstellen
Sie können nur im Rahmen des ausgewählten Bluetooth-Services nach 
verfügbaren Bluetooth-Geräten suchen.

1. Tippen Sie auf das Symbol [  ].

2. Wählen Sie <Search Option> (Suchoptionen).

3. Wählen Sie einen gewünschten Bluetooth-Service aus und 
tippen Sie auf <OK>.

Der Player sucht nach Geräten, die nur für den ausgewählten 
Service zur Verfügung stehen.
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VERBINDUNG MIT EINEM BLUETOOTH-GERÄT HERSTELLEN 
(Fortsetzung)

Ein neues Bluetooth-Gerät registrieren
Suchen Sie nach einem neuen Gerät und registrieren Sie es auf Ihrem Player. 
Sie müssen das Gerät nur ein Mal registrieren.

1. Tippen Sie auf das Symbol [ ].
Es wird nach verfügbaren Bluetooth-Geräten gesucht.

Sie können das Seitensymbol verwenden, um die Bluetooth-
Geräte in der Liste zu durchsuchen und das gewünschte
auszuwählen.

2. Ziehen Sie das ausgewählte Bluetooth-Gerät zu dem 
Symbol [  ].

3. Wählen Sie einen gewünschten Bluetooth-Service aus und 
tippen Sie auf <OK>.

Wenn Sie zur Eingabe des Passwortes aufgefordert werden, 
geben Sie <0000> ein.
Wenn das Passwort 0000 nicht akzeptiert wird, suchen Sie in der 
Bedienungsanleitung des Bluetooth-Gerätes nach dem Passwort.

Wenn die Verbindung hergestellt ist, sehen Sie die 
Verbindungsanzeige zwischen dem Symbol für das Gerät und 
dem Symbol [ ].

Der Player wird automatisch versuchen eine Verbindung zu dem Bluetooth-Gerät 
herzustellen, wenn Sie den Player oder das externe Bluetooth-Gerät neu starten.HINWEIS
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VERBINDUNG MIT EINEM BLUETOOTH-GERÄT HERSTELLEN 
(Fortsetzung)

Mit einem registrierten Bluetooth-Gerät verbinden
Sie können eine direkte Verbindung zu einem Bluetooth-Gerät herstellen, wenn 
dieses bereits im Player registriert wurde.

1. Ziehen Sie das ausgewählte Bluetooth-Gerät zu dem 
Symbol [  ].

2. Wählen Sie einen gewünschten Bluetooth-Service aus und 
tippen Sie auf <OK>.

Sie können das Seitensymbol, das sich oben rechts befi ndet, 
verwenden, um die Bluetooth-Geräte in der Liste zu durchsuchen 
und das gewünschte auszuwählen.

Wenn die Verbindung hergestellt ist, sehen Sie die 
Verbindungsanzeige zwischen dem Symbol für das Gerät und 
dem Symbol [ ].
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BLUETOOTH-STEREO-HEADSET VERWENDEN
Hören Sie Ihren Lieblingshit in bestem Sound über ein Bluetooth-fähiges Stereo-Headset 
– ganz ohne Kabel!

Bluetooth-Stereo-Headset verbinden

1. Stellen Sie eine Verbindung zu einem Bluetooth-fähigen Stereo-Headset
her.

Weitere Informationen fi nden Sie auf den Seiten 106 ~ 107.

Sobald die Verbindung hergestellt ist, wird das Symbol [  ] auf dem Display 
angezeigt.

2. Spielen Sie eine Datei Ihrer Wahl ab.
Sie können Musik über ein Bluetooth-Stereo-Headset hören.

Die Funktion Bluetooth kann nicht verwendet werden, während das UKW-
Radio aktiviert ist oder Sie Spiele spielen. Bei einigen Video- und Musikdateien 
funktioniert die Funktion während der Wiedergabe möglicherweise nicht.

Verwenden Sie nur ein Bluetooth-zertifi ziertes Stereo-Headset.

Dieser Player ist möglicherweise nicht mit allen Bluetooth-Stereo-Headsets 
kompatibel.

Bluetooth-kompatible Stereo-Headsets

Hersteller Modell
SAMSUNG YA-BS300, YA-BH270B

Sony Ericsson HBH-DS200, HBH-DS970, HBH-DS980

MobiFren GBH-S100

MOTOROLA S9-HD

I.Tech V20

HINWEISE
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BLUETOOTH-MOBILTELEFON VERWENDEN
Sie können mit Ihrem Player telefonieren oder Anrufe entgegennehmen, wenn Sie ihn an 
ein Bluetooth-Mobiltelefon anschließen. Der Player funktioniert als Freisprecheinrichtung.

Verbindung mit einem Bluetooth-Handy herstellen

Stellen Sie eine Verbindung zu einem Bluetooth-Handy her.
Sobald die Verbindung hergestellt ist, wird das Symbol [  ] auf dem Bildschirm 
angezeigt.

Es gibt Mobiltelefone, mit denen die Erkennung und die Funktionen der mobilen 
Kommunikation (Anrufe tätigen/entgegennehmen) nicht funktionieren.
Bei einem über Bluetooth mit einem Mobiltelefon verbundenen Player können 
Störgeräusche auftreten, wenn Sie auf dem Mobiltelefon eine Taste betätigen bzw. 
wenn Sie ein Gespräch führen oder beenden.
Es ist empfehlenswert, dem Mobiltelefon einen englischen Namen zu geben.

HINWEISE
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BLUETOOTH-MOBILTELEFON VERWENDEN (Fortsetzung)

Anrufe über den Player tätigen

1. Wählen Sie im Bluetooth-Display <Call by Number> 
(Nummer wählen).

2. Geben Sie die Rufnummer des gewünschten 
Gesprächspartners ein.

3. Tippen Sie auf das Symbol [  ].
Das Gespräch wird aufgebaut.

Wenn bei dem verbundenen Mobiltelefon Kurzwahlen eingerichtet sind, können 
Sie direkt vom Player aus einen Anruf tätigen, indem Sie die letzte Ziffer der 
Kurzwahl gedrückt halten.

Die zuletzt verwendete Rufnummer wählen

Wählen Sie im Bluetooth-Display <Redial> (Nochmals wählen).
Die Verbindung mit der zuletzt gewählten Rufnummer wird aufgebaut.
Je nach Telefontyp kann der aktuelle Anrufverlauf angezeigt werden. Wählen Sie die 
erste Telefonnummer im Verlauf aus.

HINWEIS
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BLUETOOTH-MOBILTELEFON VERWENDEN (Fortsetzung)

Anrufe mithilfe des Anrufverlaufs tätigen

1. Wählen Sie im Bluetooth-Display <Call History>
(Anrufverlauf).

2. Wählen Sie die gewünschte Telefonnummer.
Das Gespräch wird aufgebaut.

Eine Telefonnummer aus dem Anrufverlauf löschen

1. Tippen Sie in der Option <Call History> (Anrufverlauf) auf das Symbol
[  ].

2. Wählen Sie eine zu löschende Telefonnummer und tippen Sie auf <OK>.

3. Wählen Sie <Yes> (Ja).
Die ausgewählte Telefonnummer wird gelöscht.
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BLUETOOTH-MOBILTELEFON VERWENDEN (Fortsetzung)

Gespräche entgegennehmen

1. Bei eingehenden Anrufen wird <Connect?> (Verbinden?) 
angezeigt.

2. Wählen Sie <Yes> (Ja).
Sie können nun das Telefongespräch führen.

Während des Sprechens vom Player (YP-M1) zum 
Mobiltelefon wechseln

Wählen Sie während des Sprechens über den Player <Voice 
to Phone> (Sprache an Telefon).

Sie können jetzt über das Mobiltelefon telefonieren.

Während des Sprechens vom Mobiltelefon 
zum Player (YP-M1) wechseln

Wählen Sie während des Sprechens über den Player <Voice to Hands-free>
(Spr. an Freispr.einr.).

Sie können jetzt über die Freisprecheinrichtung (den Player) telefonieren.
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BLUETOOTH-MOBILTELEFON VERWENDEN (Fortsetzung)

Lautstärke einstellen

Während eines Gesprächs über die Freisprecheinrichtung kann die Lautstärke 
mit den Tasten [ , ] geregelt werden.

Telefongespräch beenden

Wählen Sie während der Konversation <Disconnect>
(Trennen).

Die Verbindung wird getrennt.
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DATEIEN ZUM/VOM BLUETOOTH-GERÄT ÜBERTRAGEN
Sie können Musik-, Bild- und Filmdateien von Bluetooth-fähigen externen Geräten wie 
MP3-Player, Mobiltelefon usw. auf den Player übertragen und umgekehrt.

Dateien vom Player auf ein externes Gerät übertragen

Bevor Sie beginnen - Überprüfen Sie, ob das externe Bluetooth-Gerät die 
Datenübertragungsfunktion unterstützt (siehe Bedienungsanleitung des Geräts).

1. Stellen Sie eine Verbindung zum gewünschten Bluetooth-
Gerät her.

Weitere Informationen fi nden Sie auf den Seiten 106 ~ 107.

Tippen Sie auf ein externes Gerät, zu dem Sie eine Verbindung 
herstellen möchten.

2. Wählen Sie einen Ordner aus, um dessen Dateiliste
anzuzeigen.

3. Wählen Sie eine Datei zum Übertragen aus und tippen Sie 
auf <OK>.

Die ausgewählte Datei wird auf das externe Gerät übertragen.

DRM-Dateien (kostenpfl ichtig) können mit diesem Player nicht 
wiedergegeben werden.

Datenübertragung abbrechen

Um die Datenübertragung abzubrechen, tippen Sie <Cancel> (Abbrechen).
Die Datenübertragung wird gestoppt.

HINWEIS

Bsp.: Der Bild-
schirm <File Trans-
fer> (Datenübertra-
gung) des Players
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DATEIEN ZUM/VOM BLUETOOTH-GERÄT ÜBERTRAGEN 
(Fortsetzung)

Datenübertragungsmodus beenden

1. Halten Sie im Bildschirm für die Datenübertragung und bei Anzeige der 
Dateiliste das Symbol [  ] gedrückt.

Bei jedem Antippen der Taste [  ] wird die jeweils vorherige Ebene 
aufgerufen, und das Fenster zum Schließen des Datenübertragungsmodus wird 
angezeigt.

2. Wählen Sie <Yes> (Ja).
Der Datenübertragungsmodus wird beendet.

Dateien von einem externen Gerät auf den Player übertragen
Sie können Dateien von einem externen Bluetooth-Gerät auf Ihren Player 
übertragen.

Bevor Sie beginnen - Wenn der Player bereits mit einem Bluetooth-Gerät 
verbunden ist, trennen Sie diese Verbindung zuerst.
Lesen Sie in der Bedienungsanleitung des externen Geräts nach, wie man es mit 
dem Player verbindet und die Datenübertragung ausführt.

Wenn die Bluetooth-Verbindung erscheint, wählen Sie <Yes> (Ja).
Dateien, die auf den Player übertragen wurden, befi nden sich in dem Ordner <File 
Browser> (Dateibrowser)  <Shared Data> (Gemeinsame Daten).
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BLUETOOTH-GERÄTE PRÜFEN

Verbundenes Bluetooth-Gerät prüfen
Sie können den Namen, die Adresse und die verfügbaren Services des 
verbundenen Bluetooth-Gerätes überprüfen.

1. Wählen Sie das verbundene Bluetooth-Gerät aus.

2. Tippen Sie auf das Symbol [  ].

3. Wählen Sie <Device Info> (Geräteinfo).
Informationen zum ausgewählten Gerät werden angezeigt.

Die verfügbaren Services des ausgewählten Gerätes werden 
überprüft.

Service-Symbole

 -Symbol: Stereo-Headset
 -Symbol: Mobiltelefon
 -Symbol: Dateiübertragung
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BLUETOOTH-GERÄTE PRÜFEN (Fortsetzung)

Bluetooth-Gerät trennen

1. Wählen Sie das verbundene Bluetooth-Gerät aus.

2. Tippen Sie auf das Symbol [  ].
Die Verbindung mit dem Bluetooth-Gerät wird getrennt.

Registriertes Bluetooth-Gerät entfernen
Bevor Sie beginnen - Wenn der Player mit einem Bluetooth-Gerät verbunden ist, 
das entfernt werden soll, trennen Sie diese Verbindung zuerst.

1. Wählen Sie aus der Liste der Geräte das Gerät aus, das 
Sie entfernen möchten.

2. Tippen Sie auf das Symbol [  ].
Das ausgewählte Gerät wird entfernt.
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Alarm einstellen
Dieser Player verfügt über eine Alarmfunktion, die zu einem festgelegten 
Zeitpunkt aktiviert werden kann.

Bevor Sie beginnen - Stellen Sie zunächst die aktuelle Uhrzeit ein. Informationen dazu 
fi nden Sie auf Seite 44.

ALARM EINSTELLEN
1. Wählen Sie das Symbol  im Hauptmenü.
2. Wählen Sie <New Alarm> (Neuer Alarm).
3. Tippen Sie so oft auf den ersten Menüpunkt, bis die gewünschte 

Alarmhäufi gkeit eingestellt ist.
4. Tippen Sie auf den zweiten Menüpunkt.
5. Tippen Sie auf den oberen oder unteren Bereich der Werte für 

Stunde/Minute und des Symbols AM/PM, um die gewünschte 
Alarmzeit einzustellen, und tippen Sie auf <OK>.

6. Tippen Sie so oft auf den dritten Menüpunkt, bis der gewünschte 
Alarmton gewählt ist.

7. Tippen Sie mehrfach auf den vierten Menüpunkt, um den 
Vibrationstyp festzulegen.

8. Tippen Sie mehrfach auf den fünften Menüpunkt, um das 
Alarmintervall festzulegen.

9. Tippen Sie auf <OK>.
10. Wählen Sie <Yes> (Ja).

Die Alarmeinstellung wird der Alarmliste hinzugefügt.

Sie können bis zu 7 Alarmeinstellungen speichern.
HINWEIS
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ALARM EINSTELLEN (Fortsetzung)

Alarm ausschalten

Der Alarm ertönt, sobald die eingestellte Uhrzeit erreicht ist. Um den Alarm zu 
deaktivieren, wählen Sie <Alarm Off> (Alarm aus).

Alarmeinstellung löschen

1. Tippen Sie im Menübildschirm mit der Alarmliste auf das 
Symbol [  ].

2. Wählen Sie eine Alarmeinstellung, die Sie löschen 
möchten.

Tippen Sie auf das Symbol [  ] , um alle 
Alarmeinstellungen zu löschen.

3. Tippen Sie auf <OK>.

4. Wählen Sie <Yes> (Ja).
Der gewählte Alarm wird gelöscht.

Wenn der Player an einen Computer angeschlossen ist, kann die Alarmfunktion nicht 
verwendet werden.ACHTUNG
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Datacasts anzeigen
Über Datacasts können Sie automatisch aktualisierte Informationen empfangen, 
ohne dass Sie häufi g besuchte Websites mit News, Blogs oder anderem 
benutzerdefi nierten Inhalt (UCC) jedes Mal aufrufen müssen.

Bevor Sie beginnen - Übertragen Sie die gewünschten Datacast-Inhalte mit Hilfe von 
<EmoDio> auf den MP3-Player.

DATACASTS ANZEIGEN
Sie können Inhalte anzeigen, die unter <Datacasts> hinzugefügt 
wurden.

1. Wählen Sie das Symbol im Hauptmenü.

2. Wählen Sie den gewünschten Kanalnamen aus.

-Symbol: Videodatei
-Symbol: Musikdatei
-Symbol: Bilddatei
-Symbol: Textdatei

3. Wählen Sie eine Datei aus.
Die ausgewählte Datei wird wiedergegeben.

Ausführliche Anweisungen fi nden Sie unter <Datacasts> in <EmoDio>.
HINWEIS
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Sprachaufnahmen erstellen
Sie können Sprachaufnahmen erstellen.

SPRACHAUFNAHMEN ERSTELLEN

Sprachaufnahmen erstellen

1. Wählen Sie das Symbol  im Hauptmenü.

2. Tippen Sie auf das Symbol [  ].
Die Aufnahme wird gestartet.

Halten Sie das Mikrofon weder zu nah an die Aufnahmequelle noch zu weit weg, da 
in beiden Fällen die Aufnahmequalität beeinträchtigt werden kann.
Bei schwachem Akkuladezustand erfolgt die Aufnahme möglicherweise nicht 
korrekt.

ACHTUNG
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SPRACHAUFNAHMEN ERSTELLEN (Fortsetzung)

Aufnahme beenden

1. Tippen Sie während der Aufnahme auf das Symbol
[  ].

Es wird eine Meldung angezeigt, in der Sie gefragt werden, ob 
Sie die aufgenommene Datei wiedergeben möchten.

2. Wählen Sie <Yes> (Ja) oder <No> (Nein).
Bei <Yes> (Ja) startet die Wiedergabe der aufgenommenen Datei.
Bei <No> (Nein) wird die aufgenommene Datei nicht 
wiedergegeben.

Tippen Sie auf das Symbol [  ], um die Aufnahme auf Pause zu stellen.
Die aufgenommene Datei wird im <File Browser> (Dateibrowser) unter 
<Recorded Files> (Aufgenommene Dateien)  <Voice> (Sprache) 
gespeichert.
Jede Aufnahmedatei kann eine Länge von bis zu 5 Stunden haben.

HINWEISE
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Flash-Dateien ansehen
Sie können Flash-Dateien wiedergeben (.swf-Format).

FLASH-DATEIEN WIEDERGEBEN

1. Wählen Sie das Symbol  im Hauptmenü.

2. Wählen Sie die gewünschte Shockwave-Flash-Datei aus.
Tippen Sie während der Wiedergabe auf [  ], um die 
Navigationstasten [Auf, Ab, Links, Rechts] gemeinsam mit der Taste <OK> 
(Eingabe) anzuzeigen.

Stoppuhr verwenden

1. Wählen Sie das Symbol  im Hauptmenü.

2. Wählen Sie eine Stoppuhr-Flash-Datei aus.

Manche SWF-Dateien werden möglicherweise nicht unterstützt.
Bei der Wiedergabe einiger SWF-Dateien kann sich der Player aus- und anschließend wieder 
einschalten.

HINWEISE
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Taschenrechner verwenden
Der Player verfügt über einen praktischen Taschenrechner.

TASCHENRECHNER VERWENDEN

1. Wählen Sie das Symbol  im Hauptmenü.

2. Führen Sie Berechnungen aus, indem Sie auf dem Touchscreen auf 
die Ziffern und Rechenzeichen tippen.

Tippen Sie auf das Symbol [  ], damit die Tausenderstellen der Zahlen mit (,) separiert 
werden.HINWEIS
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Adressbuch anzeigen
Sie können über Bluetooth ein Adressbuch herunterladen, eine 
Rufnummer nachschlagen und die gewünschte Person direkt mit dem 
Player anrufen.

Bevor Sie beginnen - Verwenden Sie zunächst die Datenübertragung via Bluetooth, um das 
Adressbuch von einem externen Gerät herunterzuladen. Weitere Informationen erhalten Sie 
unter <Dateien von einem externen Gerät auf den Player übertragen>. Informationen dazu 
fi nden Sie auf Seite 115.
Bevor Sie im Fenster des Adressbuchs einen Anruf tätigen können, muss Ihr Mobiltelefon 
mit dem Player gekoppelt werden. Weitere Informationen fi nden Sie unter <Bluetooth-
Mobiltelefon verwenden>. Siehe Seite 109.

ADRESSBUCH ANZEIGEN
1. Wählen Sie das Symbol  im Hauptmenü.

2. Wählen Sie einen Namen, der im Adressbuch geöffnet werden soll.
Die entsprechenden Adressinformationen werden angezeigt.

Der Inhalt des Adressbuchs wird in alphabetischer Reihenfolge angezeigt.
Die auf den Player übertragenen Dateien aus dem Adressbuch werden im Ordner <File 
Browser> (Dateibrowser)  <Shared Data> (Gemeinsame Daten) gespeichert.
Für das Adressbuch wird ausschließlich das Dateiformat vCard unterstützt.

HINWEISE
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ADRESSBUCH ANZEIGEN (Fortsetzung)

Einen Anruf im Adressbuch tätigen

1. Wählen Sie einen Namen, um die entsprechende Person 
aus dem Adressbuch anzurufen.

2. Wählen Sie die gewünschte Telefonnummer.
Das Gespräch wird aufgebaut. 

Ein Bild ins Adressbuch einfügen

1. Wählen Sie im Adressbuch einen Namen, für den Sie ein 
Bild einfügen möchten. 

2. Tippen Sie auf das Symbol [  ].
Sie können eine Vorschau des Bildes sehen.

3. Wählen Sie das gewünschte Bild aus.
Das Foto wird angezeigt, wenn der Name im Adressbuch 
ausgewählt wird.
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Fehlersuche
Falls ein Problem mit dem MP3-Player auftritt, suchen Sie zunächst in dieser 
Liste nach einer Lösung. Besteht das Problem weiterhin, wenden Sie sich an 
den Kundendienst von Samsung in Ihrer Nähe.

PROBLEM LÖSUNG

Das Gerät lässt sich nicht 
einschalten

• Das Gerät kann bei vollständig entladenem Akku nicht 
eingeschaltet werden. Laden Sie den Akku auf, und 
schalten Sie das Gerät erneut ein.

• Halten Sie die Taste [ ] länger als 10 Sekunden 
gedrückt, um den Player zurückzusetzen und neu zu 
starten.

Die Tasten funktionieren 
nicht

• Überprüfen Sie, ob die Sperrfunktion (HOLD) so eingestellt 
ist, dass sämtliche Tasten gesperrt sind.

• Überprüfen Sie, ob Sie die für die auszuführende Funktion 
geeigneten Tasten oder Symbole gedrückt haben.

• Halten Sie die Taste [ ] länger als 10 Sekunden 
gedrückt, um den Player zurückzusetzen und neu zu 
starten.

Das Display lässt sich 
nicht einschalten

• Das Display ist bei direkter Sonneneinstrahlung 
möglicherweise nicht ablesbar.

• Wenn die Option <Display Off & Hold> (Display aus&halt) 
unter <Settings> (Einstellg.) <Display> auf einen 
Wert eingestellt wurde, hat sich der Touchscreen evtl. 
ausgeschaltet.

Das Gerät schaltet sich 
aus

• Ihr MP3-Player schaltet sich automatisch aus, wenn im 
Pausenmodus 5 Minuten lang keine Tasten oder Symbole 
betätigt wurden. Schalten Sie den Player wieder ein.
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PROBLEM LÖSUNG

Die Betriebszeit des 
Akkus weicht u. U. 
von den Angaben im 
Handbuch ab.

• Die Lebensdauer des Akkus hängt vom Klangmodus und 
der Displayeinstellung ab.

• Wenn Sie das Gerät über einen längeren Zeitraum sehr 
hohen oder niedrigen Temperaturen aussetzen, kann sich 
die Lebensdauer des Akkus verkürzen.

Fehlfunktionen des 
EmoDio-Programms

• Überprüfen Sie, ob Ihr System die Mindestanforderungen 
erfüllt.

Verbindung mit dem PC
ist nicht möglich

• Überprüfen Sie, ob das USB-Kabel korrekt angeschlossen 
wurde, und versuchen Sie es erneut.

• Führen Sie auf Ihrem PC ein Windows-Update aus. 
Wählen Sie die gewünschten Updates und Service Packs 
aus, und starten Sie die Aktualisierung. Starten Sie den PC 
neu, und stellen Sie die Verbindung wieder her.

Die Datenübertragungsrate
ist zu niedrig

• Die Datenübertragungsrate ist gering, wenn Sie gleichzeitig 
mehrere Programme (einschließlich EmoDio) auf dem PC 
ausführen. Schließen Sie nicht benötigte Programme, und 
versuchen Sie es erneut.

Die Wiedergabe 
funktioniert nicht

• Überprüfen Sie, ob Dateien im Speicher des Players 
vorhanden sind.

• Überprüfen Sie, ob die gewählte Musikdatei beschädigt ist.
• Überprüfen Sie, ob der Akku ausreichend geladen ist.

Sie können keine Dateien 
hochladen

• Überprüfen Sie, ob das USB-Kabel richtig angeschlossen 
ist. Schließen Sie es gegebenenfalls noch einmal an.

• Überprüfen Sie, ob der Windows Media Player 11 oder eine 
neuere Version auf Ihrem Computer installiert ist. Wenn 
Sie eine ältere Version verwenden, installieren Sie den 
Windows Media Player 11 oder eine neuere Version.

• Überprüfen Sie, ob der Speicher voll ist.
• Halten Sie die Taste [ ] länger als 10 Sekunden 

gedrückt, um den Player zurückzusetzen und neu zu 
starten.
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PROBLEM LÖSUNG
Es fehlen Dateien bzw.
Daten

• Überprüfen Sie, ob sich das USB-Kabel gelockert hat. 
Wenn dies der Fall ist, kann es zu schweren Schäden an 
Dateien/Daten und am Player führen. Für Datenverlust 
übernimmt Samsung keine Haftung.

Ungewöhnliche
Zeitangabe während der 
Wiedergabe

• Überprüfen Sie, ob die Datei im VBR-Format (Variable 
Bitrate) gespeichert ist. In diesem Fall wird die 
Wiedergabezeit evtl. nicht korrekt angezeigt.

Fehlerhafte Anzeige des 
Dateinamens

• Stellen Sie im Hauptmenü über <Settings> (Einstellungen) 
 <Language> (Sprache) <Contents> (Inhalt) die 

richtige Sprache ein.

Der Player wird heiß • Während des Ladevorgangs kann es zu 
Wärmeentwicklung kommen. Dies hat keine Auswirkungen 
auf die Lebensdauer oder die Funktionen des Produkts.

Während der Video-
wiedergabe wird eine 
Meldung eingeblendet

• Laden Sie den Videoclip erneut mit EmoDio herunter.

Bluetooth-Verbindung 
kann nicht hergestellt 
werden

• Prüfen Sie, ob Ihr Stereo-Headset Bluetooth-fähig ist. 
• Die Bluetooth-Verbindung wurde beim Aus- und 

Wiedereinschalten des Players oder des Stereo-Headsets 
möglicherweise getrennt. Stellen Sie in diesem Fall die 
Verbindung erneut her

• Wenn Sie Ihr Mobiltelefon für Telefongespräche nutzen 
möchten, prüfen Sie, ob Bluetooth-Verbindungen zwischen 
Player und Stereo-Headset deaktiviert wurden.



130 _ Anhang

Ton Display Sprache Zeit System

Anhang
MENÜ-ÜBERSICHT
Kurzübersicht über die Organisationsstruktur der Menüs und Funktionen des MP3-
Players.

Menü-Bildschirm

Dateibrowser Alarm Einstellungen

Videos Musik Bilder

Flash Player Texte micro SD

UKW-Radio Spiele Bluetooth

Datacasts Sprachaufn. Adressbuch

Taschenrechner
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TECHNISCHE DATEN
Modellname YP-M1
Leistung 5,0 V Gleichspannung, 1 A

Kompatible
Dateiformate

AUDIO

MPEG1/2/2.5 Layer3 (8 kbps ~ 320 kbps, 8 kHz ~ 48 kHz),
WMA (8 kbps ~ 320 kbps, 8 kHz ~ 48 kHz),
AAC-LC (16 kbps ~ 256 kbps, 8 kHz ~ 48 kHz),
AAC-Plus (16 kbps ~ 256 kbps, 16 kHz ~ 44.1 kHz),
Enhanced-AAC-Plus (16 kbps ~ 56 kbps, 32 kHz ~ 44.1 kHz),
16Bit linear PCM , FLAC, Ogg(Q0 ~Q10)

VIDEO

Video Audio

AVI/
SVI

 MPEG4 (max. 720X480) Einfaches Profil
 Divx 4/5 (max. 720X480)

MP3/AAC/
AAC+/AC3

 H.264 (max. 1280X720) Baseline-Profil AAC

MP4
 MPEG4 (max. 720X480) Einfaches Profil
H.264/AVC (max. 1280X720) Baseline-
Profil @ Level 1.3

MP3/AAC/
AAC+

WMV/
ASF

WMV7/8 (640X480) WMV9 Hauptprofil 
(1280x720) WMA

MOV
MPEG4 (max. 720X480) Einfaches Profil
 H.264 (max. 1280X720) Baseline-Profil

AAC/
AAC+

BILD JPEG (Baseline, Progressive), BMP (max. 32 bit), PNG

FLASH SWF (Flash Player 8.0 oder niedriger, ActionScript 2.0 
oder niedriger)

TEXT TXT
Ausgangsleistung
Ohrhöreranschluss 20 mW/Kanal (Frankreich 5 mW/Kanal) (basierend auf 16 )

Frequenzbereich 20 Hz ~ 20 kHz
Signal/Rausch-Abstand 91 dB bei 20 kHz LPF (basierend auf 1 kHz, 0 dB)
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TECHNISCHE DATEN (Fortsetzung)

Unterstützte Anzahl 
Ordner/Dateien

Dateien: max. 5000
Ordner: max. 5000 (einschließlich Dateien)

Betriebsdauer (bei 
Verwendung von Ohr-/ 
Kopfhörern)

Musik: max. 30 Stunden (MP3 128 kbit/s, Lautstärke: 15, normaler 
Tonmodus, Display aus)

Video:  max. 5 Stunden (Helligkeit 3, Lautstärke: 15, normaler 
Tonmodus)

Umgebungstemperatur
bei Betrieb -5 ~ 35°C

Gehäuse Hartglas, rostbeständig
Gewicht 91 g
Abmessungen (B x H x T) 54,2 x 98,9 x 9,9 mm

Lautsprecher Ausgabeleistung: 0,7 W

Impedanz 8

Frequenzbereich 400 Hz bis 20 kHz

UKW-Radio UKW-Signal/Rausch-
Abstand 40 dB

Nutzbare UKW-
Empfi ndlichkeit 30 dB

Gesamtklirrfaktor UKW 0,5 %
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TECHNISCHE DATEN (Fortsetzung)

Bluetooth-Daten
Bluetooth QD ID B015438
Funkbetriebsart F1D
Sendefrequenz 2402 MHz ~ 2480 MHz
Empfangsfrequenz 2402 MHz ~ 2480 MHz
Anzahl der Kanäle 79 Kanäle
Modulationssystem GFSK, 8DPSK
Kommunikationsmodus Halb-Duplex-Betrieb
Luftfeuchtigkeit 0 ~ 95 %
Unterstützte Version 2.1 + EDR
Modul BC06-ROM

Der Inhalt dieses Handbuchs kann aufgrund von Weiterentwicklung ohne vorherige 
Ankündigung geändert werden.
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LIZENZ
Das Gerät, zu dem dieses Benutzerhandbuch gehört, unterliegt den Bestimmungen zum 
geistigen Eigentum dritter Personen (Urheberrechtsschutz). Die Lizenz beschränkt sich 
auf die private, nichtkommerzielle Nutzung durch Endverbraucher im Zusammenhang 
mit lizenzierten Inhalten. Es sind keinerlei Rechte für die kommerzielle Nutzung erteilt. 
Die Lizenz erstreckt sich lediglich auf dieses Gerät und deckt keine unlizenzierten 
Produkte oder Prozesse gem. ISO/IEC 11172-3 oder ISO/IEC 13818-3, die mit diesem 
Gerät verkauft oder durchgeführt werden. Die Lizenz erstreckt sich lediglich auf die 
Verwendung dieses Gerätes zum Kodieren/Dekodieren von Musik-/ Videodateien gem. 
ISO/IEC 11172-3 oder ISO/IEC 13818-3. Im Rahmen der Lizenz werden keine Rechte für 
Produktmerkmale oder Funktionen gewährt, die nicht der ISO/IEC 11172-3 oder ISO/IEC 
13818-3 entsprechen.

“Protected by U.S. patents of Immersion Corporation.
A list of applicable patents can be found on Immersion’s 
website at www.immersion.com.”
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KORREKTE ENTSORGUNG VON ALTGERÄTEN (ELEKTROSCHROTT)
(In den Ländern der Europäischen Union und anderen europäischen Ländern mit einem 
separaten Sammelsystem) 
Die Kennzeichnung auf dem Produkt, auf Zubehörteilen bzw. auf 
der dazugehörigen Dokumentation gibt an, dass das Produkt und 
Zubehörteile (z. B. Ladegerät, Kopfhörer, USB-Kabel) nach ihrer 
Lebensdauer nicht zusammen mit dem normalen Haushaltsmüll 
entsorgt werden dürfen. Entsorgen Sie dieses Gerät und Zubehörteile 
bitte getrennt von anderen Abfällen, um der Umwelt bzw. der 
menschlichen Gesundheit nicht durch unkontrollierte Müllbeseitigung 
zu schaden. Helfen Sie mit, das Altgerät und Zubehörteile fachgerecht 
zu entsorgen, um die nachhaltige Wiederverwertung von stoffl ichen 
Ressourcen zu fördern. Private Nutzer wenden sich an den 
Händler, bei dem das Produkt gekauft wurde, oder kontaktieren 
die zuständigen Behörden, um in Erfahrung zu bringen, wo sie das 
Altgerät bzw. Zubehörteile für eine umweltfreundliche Entsorgung abgeben können.
Gewerbliche Nutzer wenden sich an ihren Lieferanten und gehen nach den Bedingungen des 
Verkaufsvertrags vor. Dieses Produkt und elektronische Zubehörteile dürfen nicht zusammen 
mit anderem Gewerbemüll entsorgt werden.

KORREKTE ENTSORGUNG DER BATTERIEN DIESES PRODUKTS
(In den Ländern der Europäischen Union und anderen europäischen Ländern mit einem 
separaten Altbatterie-Rücknahmesystem).
Die Kennzeichnung auf der Batterie bzw. auf der dazugehörigen 
Dokumentation oder Verpackung gibt an, dass die Batterie zu diesem 
Produkt nach seiner Lebensdauer nicht zusammen mit dem normalen 
Haushaltsmüll entsorgt werden darf. Wenn die Batterie mit den 
chemischen Symbolen Hg, Cd oder Pb gekennzeichnet ist, liegt der 
Quecksilber-, Cadmium- oder Blei-Gehalt der Batterie über den in der 
EG-Richtlinie 2006/66 festgelegten Referenzwerten. Wenn Batterien 
nicht ordnungsgemäß entsorgt werden, können sie der menschlichen 
Gesundheit bzw. der Umwelt schaden. Bitte helfen Sie, die natürlichen 
Ressourcen zu schützen und die nachhaltige Wiederverwertung von stoffl ichen Ressourcen zu 
fördern, indem Sie die Batterien von anderen Abfällen getrennt über Ihr örtliches kostenloses 
Altbatterie-Rücknahmesystem entsorgen.





Falls Sie Fragen oder Anregungen zu Samsung-Produkten haben,
wenden Sie sich bitte an den Samsung-Kundendienst.

Samsung Electronics GmbH
01805 - SAMSUNG(726-7864 € 0,14Min) 

www.samsung.de\

REV. 0.0


